
 

 

 

 

 

Versatile Data Exchange 

VD-X1 
 

 

ユーザーズマニュアル 
 

ご使用前にこのユーザーズマニュアルをよくお読み下さい。 

お読みになったあとは、いつでも見られるところに大切に保管して下さい。 

 

 

お断り 

本書に記載の各会社名、商品名は各社の商標または登録商標です。 

本書の内容については将来予告なしに変更することがあります。 

 

2005 年 10 月 Revision 1.0.1  

 



 

 

 
 
 
 

注 意 

この装置は、情報処理装置等電波障害自主規制協議会（VCCI）の基準に

基づくクラスＡ情報技術装置です。この装置を家庭環境で使用すると電波妨

害を引き起こすことがあります。この場合には使用者が適切な対策を講ずるよ

う要求されることがあります。 

 
 
 
 
 
 
 
 
 
 
 
 
 
Note: 
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安全にお使いいただくために 
 

 

この記号は注意（警告を含む）を促す内容があることを告げるものです。 

 

この記号は禁止の行為であることを告げるものです。 

図の中に具体的な禁止内容（左図の場合は分解禁止）が描かれています。 

 

この記号は行為を強制したり指示する内容を告げるものです。 

図の中に具体的な指示内容（左図の場合は電源プラグをコンセントから抜け）が描かれています。 

 

 警告  

この表示を無視して、誤った取扱いをすると、人が死亡または重傷を負う可能性が想定される内容を示しています。 

 

■ 異常が起きたら 

万一、煙が出ている、変なにおいや音がするなどの異常状態のまま使用すると、火災・感電の原因となります。すぐに本体の電源

スイッチを切り、電源プラグをコンセントから抜いて下さい。煙が出なくなるのを確認して当社サービス部門に修理をご依頼下さい 

 

■ カバーを開けない 

この機器のカバーは絶対に外さないで下さい。感電の原因となります。内部の点検・修理は当社サービス部門にご依頼下さい。

この機器を改造しないで下さい。火災・感電の原因となります。 

 

■ ケーブルを傷つけない 

ケーブルの上に重いものをのせたりしないで下さい。コードを傷つけたり、加工したり、無理に曲げたり、ねじったり、引っ張ったり、加

熱したりしないで下さい。 

火災・感電の原因となります。 

■ 仕様の電源電圧以外の電圧で使用しない 

仕様の電源電圧以外の電圧で使用しないで下さい。火災・感電の原因となります。 

 

■ 水にぬらさない 

この機器を水にぬらさないで下さい。内部に水が入ったまま使用すると、火災・感電の原因となります。内部に水が入った場合

は、まず本体の電源スイッチを切り、電源プラグをコンセントから抜いて当社サービス部門にご連絡下さい。 

 

 注意  

この表示を無視して、誤った取り扱いをすると、人が傷害を負う可能性が想定される内容および物的損害の発生が想定される

内容を示しています。 

 

■ 適さない設置場所 

次のような場所に置かないで下さい。火災、感電やけがの原因となることがあります。 

- 調理台や加湿器のそばなど油煙や湯気があたる場所              - 湿気やほこりの多い場所 

- ぐらついた台の上や傾いた所など不安定な場所                   - 直射日光があたる場所 

■ ぬれた手でプラグにさわらない 

感電の原因となることがあります。 

 

■ 長期間ご使用にならないときは 

長期間この機器をご使用にならないときは、電源コードをはずして保管して下さい。 
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保証規定 

 

ハードウェア 
 
� 保証期間はお買い上げ日から 1 年間です。 

取扱説明書、本体貼付ラベルなどに従った正常な使用状態で、保証期間内に故障が発生した場合には、最寄りのティアック

電子計測株式会社（以下、当社といいます）営業所、またはサービス部門が無料修理いたします。 

 

� 保証期間内に故障して無料修理を受ける場合は 

本製品の取扱店、最寄りの当社営業所、またはサービス部門にご依頼下さい。なお、離島および離島に準ずる遠隔地への出

張修理を行った場合には、出張に要する実費を申し受けます。 

データ、収録媒体、当社製以外の装置又は部品、機構、付加物、改造を事前に本製品から取り外して下さい。 

 

� つぎの場合には保証期間内でも有料修理となります。 

１） ご使用上の誤りおよび不当な修理や改造による故障および損傷 

２） お買い上げ後の輸送、移動、落下などによる故障および損傷 

３） 火災、地震、水害、落雷、その他の天災地変、公害や異常電圧による故障および損傷 

４） 接続している他の機器に起因する故障および損傷 

５） 異常摩耗、異常損傷を除き、自然消耗とみなされた消耗部品による故障および損傷 

６） 特殊業務または特に苛酷な条件下において使用された場合の故障および損傷 

７） 点検のためのメンテナンス 

 

� 上記は、当社製品のハードウェア部に関する保証の全てを規定したものであり、法律上の瑕疵担保責任を含む全ての明

示又は黙示の保証責任に代わるものです。当社の保証責任は、本製品の修理又は交換に限られます。当社は、いかな

る場合にも、お客様の逸失利益及び第三者からお客様に対してなされた賠償請求に基づく損害については責任を負いか

ねます。 

 

� 上記保証は、日本国内においてのみ有効です。 

 

� 保証期間経過後の修理は 

本製品の取扱店、最寄りの当社営業所、またはサービス部門にお問い合わせ下さい。 

 

� 保証内容に対するお客様の権利について 

この保証内容によって保証を発行している者（保証責任者）、およびそれ以外の事業者に対するお客様の法律上の権利を制

限するものではありません。 

 

 

ソフトウェア 
 

� 保証期間は、お買い上げ日から 90 日間です。 

当社は、当社製品のソフトウェア（以下、本ソフトウェアといいます）が、取扱説明書に記載の環境を満たすコンピュータ上に正し

くインストールされていることを前提として、取扱説明書に記載の機能を履行することを保証します。本ソフトウェアが保証期間中

に所定の機能を履行しない場合、お客様は、ご購入店を通じて修正を要求することができます。万一修正不能な場合は、返

金手続きをとらせていただきます。なお、上記は、本ソフトウェアの操作が中断しないことや誤りのないことを保証するものではあり

ません。 

 

� 派生的損害の免責: 当社は、本ソフトウェアの使用や使用不能から生じたいかなる損害（事業上の損失、営業の中断、

営業上の情報の損失、その他の金銭上の損害など）についても責任を負いません。たとえ、その損害の可能性が当社に事

前に知らされていたとしても同様です。 

 

� 上記保証は、日本国内においてのみ有効です。 

 

� 保証内容に対するお客様の権利について 

この保証内容によって保証を発行している者（保証責任者）、およびそれ以外の事業者に対するお客様の法律上の権利を制

限するものではありません。 
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ソフトウェア使用契約 
 

� ティアック電子計測株式会社（以下、当社といいます）の製品に付属するソフトウェア（以下、本ソフトウェアといいます、別

途個別に使用許諾契約が明示されるものを除きます。）は、お客様が以下のソフトウェア使用契約の条件に同意されるこ

とを前提として、ご使用を許諾するものです。万一、同意頂けない場合は、パッケージ全てをご購入店へご返却下さい。購

入代金を返金させて頂きます。お客様が以下のソフトウェア使用契約の条件に違反されますと、当社の権利を侵害するこ

とになり、以降のご使用の停止、また、損害賠償等の請求対象となりますことをご承知おき下さい。 

 

� 本契約は、お客様が本ソフトウェアのインストールを開始したときから発効します。ご同意頂けない場合は、インストールをし

ないで下さい。既にインストール済みの場合は直ちにソフトウェアの実行を終了し、アンインストールして下さい。 

 

� 当社は、本ソフトウェアを１台のコンピュータ上で<使用>する権利をお客様に許諾します。 

 

� お客様が本ソフトウェアを取得されたことは、本ソフトウェア契約に規定された以外に本ソフトウェアのいかなる権利、権原若

しくは利権の取得を意味するものではありません。お客様は、本ソフトウェアが当社に帰属する著作物として<万国著作権

条約>または<文学的および美術的著作物保護に関するベルヌ条約>の加盟国の著作権法に基づき保護されることをご

認識下さい。本ソフトウェアの著作権は当社に帰属しております。 

 

� お客様は、本ソフトウェアをバックアップ以外の用途で複製することはできません。 

お客様は、本ソフトウェアの解析をしたり、コンパイラ言語やアセンブラ言語に変換することはできません。 

お客様は、本ソフトウェアを当社の事前承諾無く、第三者に譲渡することはできません。 

 

� 上記契約に関し、ご不明な点等ございましたら、下記宛にご連絡下さい。 

 

 

 

連絡先: 

ティアック電子計測株式会社 〒211-0067 神奈川県川崎市中原区今井上町 83 

  CS 課 

  電話:  044-711-5221 

  FAX:  044-711-5240 

  E メール:  tic_cs@tic.teac.co.jp 
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第 1 章 概要 
 
1.1. 本マニュアルについて 

本マニュアル-概要・ハードウェア編では、VD-X1 各機能の使い方の概要およびハードウェアについて説明します。 

 

マニュアル上の表記について 

本体のパネル上のプッシュボタンを「キー」と呼びます。 

本体操作においてディスプレイ上の設定内容の選択で、ハイライト表示されることをカーソル表示、ハイライトをカーソルと呼びます。 

VD-X1 のディスプレイや PC ソフトウェアで表示される項目やメッセージを<MENU>や<Are you sure?>のように表記します。 

VD-X1 のディスプレイや PC ソフトウェア上のコントロールボタン、または選択項目を[REC]のように表記します。 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

簡単に VD-X1 をお使いいただくための操作チュートリアルは、本章に記載します。 
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1.2. 製品の特長 

Versatile Data Exchange (VD-X1)は、Controller Area Network (CAN)とアナログ信号の複合収録とモニターを目的とした、スタンドアロンタイプのデータ

ロガーです。 

収録データは内蔵のメモリーカードに保存されます。本体は、Ethernet で接続された PC から操作することもできます。 

CAN 信号は発生タイミングのタイムスタンプをつけて収録、アナログ信号はサンプリングベースで収録することで、信号発生ベースの解析を行うことができ、PC

アプリケーションプログラムでは、タイムスタンプをもとに CAN とアナログ信号のデータ処理を行うことができます。 

CAN シグナル収録では、収録されたデータの生値に対してあらかじめ設定されたデータベース情報を元に、物理量に変換してモニターや PC アプリケーションプ

ログラムによる波形再生時に表示します。 

 

z CAN 2 ポート使用可能、CAN パケットの丸取りと、 CAN シグナル収録モードでは 32 シグナル/ポートの収録ができます。 

z アナログ信号は、±1、2、5、10 V レンジの選択が可能で 1 kHz 8 チャネルの収録ができます。 

z FAT32 に対応し大容量メモリーカードの使用ができ長時間収録も可能です。ただし当社推奨の CFRカード、(株)ハギワラシスコム Z-Pro シリーズ

(128MB ～ 2GB) (2005 年 10 月現在) 

z データモニター用に 1024 x 768 の高解像度カラーLCD を搭載しました。 

z 市販の無線 LAN カードの使用ができます。(ただし当社検証済みのもの) 

z エラーフレームの収録や CAN バス統計機能も搭載しています。 

z 設定と波形表示の 2 本のユーティリティソフトウェアを付属しました。 

 

 

1.3. 関連ソフトウェア 

VD-X1 には次のソフトウェアが用意されています。 

 

付属ユーティリティ(CD にて供給) 

z VdRmt プログラム: PC との接続、設定、操作を行うためのプログラムです。 

z VdView 波形再生プログラム: 収録されたデータファイルをオフラインで波形表示を行うためのプログラムです。 

 

 

Page 2 



VD-X1 User’s Manual 
第 1章 概要 

1.4. 操作チュートリアル 

VD-X1 をお使いいただくための操作手順の概略を説明します。 

 

VD-X1 本体にてデータ収録とモニターを行うためには、まず、収録条件の設定を行います。 

 

設定は、VD-X1 本体にても行うことができますが、データベースの読み込みによる収録項目や収録シグナルの設定など、より簡単に設定を行うためには、付

属の VdRmt プログラムを用いて、VD-X1 本体とオンラインで設定操作を行う、または、VdRmt プログラムを用いて設定ファイル(CND ファイルと呼びます)をあ

らかじめ作成し、メモリーカードに保存し VD-X1 でその設定ファイルを読み出すことで行うことができます。 

 

z 収録シグナルの設定にあたっては、データベースファイルを読み込むことができ、これらのファイルに規定された内容を元に設定を行うことができます。 

 

z 設定された条件に基づいて、VD-X1 本体のキー操作、または専用のリモコンにて、収録スタンバイ、スタート、ストップなどの動作を行うことができます。 

 

z 本体の操作キーを用いて、メモリーカードから読み込まれた設定内容を変更することもできます。 

 

z 収録されたファイルは、VD-X1 本体の簡易再生機能にて確認することができます。 

 

z 収録されたデータファイルは PC に転送、あるいはメモリーカードからコピーして、付属の Windows アプリケーションプログラム VdView で波形表示再生を

行うことができます。 

 

ユーザーズマニュアルでは、VdRmtプログラムと VD-X1本体に同様の操作がある場合、同一の章に記載しています。 
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Note: 
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第 2 章 各部の名称 
 
2.1. トップパネル 

 
 
 
 
 ①
 
 ② 
 
 
 
 
 
 
 
 
 
 
 
 
 
 ④  ⑤
 ③
 
 
 
 

⑥ 
⑦ ⑨⑧ ⑩ ⑪ ⑫ 

 
 
 
 

名称 説明 

① POWER LED 電源 ON 時に緑に点灯します。 

② LCD ディスプレイ 1024 x 768 ピクセルのカラー液晶です。 

③ ブザー キー操作に連動してブザーを鳴らすことができます。 

④ MENU キー メインメニューを表示します。 

⑤ ▴▾◂▸(上下左右)キー 選択項目、カーソル表示を移動します。 

⑥ ENTER キー 選択された内容を確定します。 

⑦ STOP キー 収録・再生を停止します。アイドル状態でキー上の LED が点灯します。 

⑧ REC キー REC STANDBY 状態にします。LED が点灯します。 

⑨ FWD キー REC STANDBY 状態で、このキーが押されると収録を開始します。LED が点灯します。 

⑩ PAUSE キー 収録を一時停止します。LED が点灯します。この状態で、FWD キーが押されると収録を開始します。 

⑪ EVENT キー EVENT マークを収録します。 

⑫ SHIFT キー 収録中に、収録ファイル名などの収録条件を表示します。 
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2.2. リアパネル 

リアパネルには、信号の入出力用コネクタや PC との接続用インタフェース、および電源スイッチなどが配置されています。 

 

 

① ② ③ ④ ⑤ 

 

 

 

 

 ⑥ ⑦ ⑧
 

 

 

 

名称 説明 

① POWER スイッチ 電源スイッチです。どちらかの方向に押すと電源が入ります。電源 ON の状態でスイッチを押すと電源が OFF になります。

② CONTROL コネクタ オプションのリモコンを接続します 

③ CAN2 コネクタ CAN 信号用入力ポートです。CAN2 ポートとして使用します。 

④ CAN1 コネクタ CAN 信号用入力ポートです。CAN1 ポートとして使用します。 

また、12 V DC の電源の入力ピンも備えています。 

⑤ ANALOG INPUT コネクタ 8 チャネルのアナログ信号を入力します。 

⑥ DC IN コネクタ 付属の AC アダプタを接続します。または、外部 DC 電源を接続することもできます。 

⑦ LAN コネクタ PC との接続用 100BASE-TX インタフェースです。 

⑧ DISPLAY コネクタ 外部の VGA モニターを接続することができます。(画面サイズ 1024 x 768) 

  

 

各コネクタの詳細については、「第 3章 設置と接続」を参照して下さい。 

 

 
2.3. フロントパネル 

メモリーカードスロットがあります。 

PC メモリーカード用のスロットは、上下どちらか片方が使用可能です。VD-X1 は挿入されたスロット位置を自動的に検出します。 

PC メモリーカードを使用しながら、片方の空きスロットに無線 LAN カードなどの通信カードを挿入することもできます。 

 

 

2.4. サイドパネル 

固縛用の金具が 4 箇所にあります。金具の位置は縦方向にも変更できます。また、取り外すこともできます。 

金具位置の変更についてはお問い合わせ下さい。 
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第 3 章 設置と接続 
 
3.1. 設置 

本体 4 箇所にある固縛用金具を用いて、本体を車両のシートなどに固定して下さい。 

固縛金具の取り付け方向は、変更することができます。当社までお問い合わせ下さい。 

 

 注意 
本体サイドパネルの FAN と空気口は絶対に塞がないようにして下さい。塞いでしまうと内部温度が上昇しシステムがダウンする恐れがあります。また、FAN に

取り付けてあるフィルタについた埃は使用前に取り除いて、空気が取り込めるようにして下さい。 

 
 
3.2. 接続 

入出力信号の接続 

本体には、2 つの CAN ポート、および 8 チャネルのアナログ入力を同時に接続することができます。 

入出力信号はすべて本体リアパネルにあるコネクタに接続します。 

 

CAN1 コネクタ 

CAN1 として使用します。また、本体動作電源として 12V DC の入力ができます。 

 

本体側コネクタ: D-SUB 9 ピン オス 

ピン番号 機能 説明 

1 未使用  

2 CAN1   CAN_L (Low level @ dominant)  

3 GND  

4 Not connected  

5 Shield  

6 未使用  

7 CAN1   CAN_H (High level @ dominant)  

8 未使用  

9 VB (+12 V DC) VD-X1 動作電源 

 
 
CAN2 コネクタ 

CAN2 として使用します。 

 

本体側コネクタ: D-SUB 9 ピン オス 

ピン番号 機能 説明 

1 未使用  

2 CAN2   CAN_L (Low level @ dominant)  

3 GND  

4 未使用  

5 Shield  

6 未使用  

7 CAN2   CAN_H (High level @ dominant)  

8 未使用  

9 Not connected  
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OBDII_D-SUB ケーブル 

車両 OBDII 端子と VD-X1 の接続用ケーブルについては当社までお問い合わせ下さい。 

このケーブルの仕様は下記となっています。 

 
 
ANALOG INPUT コネクタ 

8 チャネルのアナログ信号を入力します。 

 

本体側コネクタ: D-SUB 9 ピン メス 

ピン番号 機能 説明 

1 チャネル 1 +  

2 チャネル 2 +  

3 チャネル 3 +  

4 チャネル 4 +  

5 チャネル 5 +  

6 チャネル 6 +  

7 チャネル 7 +  

8 チャネル 8 +  

9 GND  

 
 
BNC_D-SUB ケーブル CL-CANDY8 

BNC コネクタ(x 8)のついたアナログ信号入力用ケーブル(オプション)を用意しています。 
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CONTROL コネクタ 

リモコン(ER-VDRC)接続用のコネクタです。 

 

本体側コネクタ: ヒロセ DX20G1M-14SE 

適合プラグ: ヒロセ DX30AM-14P 

ケースカバー: ヒロセ DX30M-14-CV 

ピン番号 機能 説明 

1 START (FWD) Input(VD-X1 本体への入力信号) 

2 STOP Input 

3 EVENT Input 

4 REC Input 

5 RESERVED  

6 SYNC CLK Output(VD-X1 本体からの出力信号) 

7 GND  

8 START (FWD) LED Output 

9 STOP LED Output 

10 EVENT LED Output 

11 REC LED Output 

12 RESERVED  

13 AD START CLK Output 

14 GND  

 
 

 注意 
VD-X1 本体の制御を行うためには、該当のピンと GND を短絡します。その際、約 10mA の電流が流れますので注意して下さい。 
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3.3. 電源の接続 

VD-X1 は、12 V DC で動作します。VD-X1 への電源の供給方法は 2 種類あります。 

 

 注意 
DC 電源の動作保証電圧範囲は、10 V DC ～ 17 V DC となっています。それ以外の電圧範囲での使用は絶対に行わないで下さい。機器の破損、または

予期せぬシステムシャットダウンの可能性があります。 

 

① リアパネルの DC IN コネクタへの電源供給 

付属の AC アダプタを用いて、電源を供給することができます。机上での作業に便利です。 

 

本体側コネクタ:  

ピン番号 機能 説明 

1 +12 V  

2 NC  

3 NC  

4 GND  

 
 

② CAN1 コネクタへの電源供給 

車両 OBDII 端子にでているバッテリ電圧(12 V DC)を、CAN などの信号とともに VD-X1 へ接続する場合に便利です。 

 

CAN1 コネクタのピン配列については、前項の「入出力信号の接続」を参照して下さい。 

 

①、②とも同時に接続することが可能です。VD-X1 ではどちらか電圧の高い方の電源を使用します。 

 

外部バッテリの使用について 

DC IN コネクタに外部バッテリを接続することもできます。 

また、この外部バッテリを利用して、CAN1 コネクタへの車両側からの電源供給が、クランキングなどで降下する場合の、動作バックアップを行うこともできます。

その場合、外部バッテリの電源電圧は、12 V より低く(11.5 V 程度)にして下さい。外部バッテリ側の電圧が車両側からの供給電圧よりも高い場合は、先に

外部バッテリを使用することとなりバックアップの用途を果たしません。 

 

 

 注意 
動作中に何らかの原因でシステムが異常となり、その後電源が立ち上がらない場合は、一旦、電源供給ケーブルをすべて本体からはずし、再接続を行ってか

ら起動を行って下さい。 
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第 4 章 起動と終了 
 
4.1. VD-X1 の起動 

1. 「3.3. 電源の接続」にしたがって VD-X1 に電源を供給して下さい。 

 

2. リアパネルにある[POWER]を押します。(どちらの方向でもかまいません。) 

 

 

 

 

 

 

 

 

3. トップパネル右上の[POWER LED]が緑に点灯します。 

 

4. 約 20 秒で、メイン画面が起動します。 

表示内容は、前回の設定内容により異なります。 

VD-X1 本体は、前回の設定内容を保持してその内容で起動します。 

 

 

 

 

 

 

 

 

 

 

4.2. VD-X1 の終了 

1. VD-X1 が<READY>状態のときに(画面左下のステータス表示が<READY>、[STOP]のオレ

ンジ色の LED が点灯)リアパネルにある[POWER]を押します。(どちらの方向でもかまいません。) 

 

2. 約 20 秒で電源 OFF の状態になります。 

 

 注意 
動作中に何らかの原因でシステムが異常となり、その後電源が立ち上がらない場合は、一旦、電源供給ケーブルをすべて本体からはずし、再接続を行ってか

ら起動を行って下さい。 

 

4.3. 本体起動時オプション 

VD-X1 では起動時(電源投入時)のオプションとして、次のような動作モードの選択を行うことができます。 

これら動作モードの選択は、VdRmt プログラム、および VD-X1 本体の<SYSTEM>メニューにて行うことができます。 

設定方法は、「7.9. システムの設定」を参照して下さい。 

 

項目 機能 選択 

BootOnREC 電源 ON でシステム起動後、自動的に REC スタンバイ状態にする([REC]の押された状態) 有効/無効 

DirectREC REC スタンバイ状態になると自動的に REC 状態(収録状態)にする 

(BootOnREC と組み合わせることで、電源 ON でシステム起動ご自動的に収録状態になります。) 

有効/無効 

AutoCnd 自動設定ロード 

システム起動時に、メモリーカードにあらかじめ保存された設定ファイル(CND ファイル)を読み込み、その

内容にしたがって本体の設定を変更する 

ただし、この機能はメモリーカードに設定ファイルが一つだけ保存されていることが条件となります。複数

設定ファイルが保存されている場合、設定ファイル選択画面が表示されます。 

有効/無効 

 

 注意 
DirectREC 有効では、REC スタンバイ状態に入ると自動的にREC 状態(収録状態)となります。したがって、後述するトリガによる収録を開始する場合は、必

ず DirectREC は無効にして下さい。 
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第 5章 プログラムのインストールと起動・終了 
 
5.1. プログラムのインストール 

 

 注意 

VdRmt プログラムの推奨動作環境を示します。 

CPU:   Pentium IV 850 MHz 以上 

OS:  Windows 2000/XP  

メモリー:  256 MB 以上推奨 

HDD の空き: 転送するデータファイル量以上の空き容量 

LAN ポート:  100BASE-TX 

CD-ROM ドライブ: 付属ユーティリティディスク読み取り用 

 

1. 付属の CD の中の、VdRmt フォルダにあるすべてのファイルをご使用になる PC のワーキングディ

レクトリにコピーして下さい。 

 

2. ディレクトリには、左記のアイコンで示される VdRmt 実行ファイルとともに、次のファイルがコピー

されます。 

 

ファイル名・フォルダ名 内容 

VdRmt.exe プログラム実行ファイル 

TeeChartX.ocx PC 側リアルタイム波形表示グラフ用 OCX 

InstallTeeChartX.bat 上記 OCX のレジストリ登録バッチファイル 

UnInstallTeeChartX.bat 上記 OCX のレジストリからの削除バッチファイル 

下記のフォルダやファイルは、一度プログラム

が実行されると自動的に生成されます。 

 

ParamFiles 波形表示情報の自動保存先フォルダ 

 

3. TeeChartX.ocx をレジストリに登録するために、InstallTeeChartX.bat をダブルクリックして

実行して下さい。 

 
5.2. プログラムの起動・終了 

1. VdRmt アイコンをダブルクリックするとプログラムを起動します。 

<VDRemote>を表示します。 

 

2. プログラムを終了するには、ウィンドウ右上の        をクリック、または、メニューバーの 

[ファイル(F)] ⇒ [アプリケーションの終了(X)]をクリックします。 

 

 

 

 

 

 

 
 

Page 13 



 

5.3. <VDRemote>基本操作 

<VDRemote>では次の操作ができます。 

 

コントロールバー:  

アイコンをダブルクリックすると 

各設定メニューを起動します 

設定ウィザードを起動します 

保存された設定ファイル(CND ファイル)の読み出し 

VD-X1 本体との接続/切断 

作成した設定条件をファイル(CND ファイル)に保存 

ヘルプ 

メインバー

接続開始後有効、左より、 

REC: REC スタンバイ STOP: 収録停止 

FWD: REC スタンバイ状態でクリックすると収録を開始 

ファイルコピー: VD-X1 に挿入されたメモリーカードに保存されたデータを PC に転送

インジケーターバー: 

接続時、VD-X1 の動作

状態を表示 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

各バーは、メニューバー
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第 6章 PC との接続 
 
6.1. PC との接続 

VdRmt プログラムでは、<VDRemote>からの操作で、 

z データベースを参照しての VD-X1 設定ファイルの生成 

z VD-X1 と通信接続を行って設定、収録開始・終了操作 (リモート操作、収録は VD-X1 のメモリーカードへ) 

z VD-X1 で収録中のデータのリモートモニター 

z VD-X1 上の収録済みファイルの PC への転送 

を行うことができます。 

 

VD-X1 の一部の設定変更は、VD-X1 本体でも可能ですが、基本的には、VdRmt プログラムを使用しオンラインで設定、あるいは設定ファイル(CND ファイ

ル)を作成し、収録用メモリーカードに保存、VD-X1 本体操作でその設定ファイルを読み込む操作を行います。 

ここでは、PC からの VD-X1 リモート操作を行うにあたって、VD-X1 との通信接続方法について説明します。 

 

6.2. ネットワーク設定 

VD-X1 と PC は、100BASE-TX Ethernet (VD-X1 本体リアパネルの LAN コネクタ)を利用した有線接続、または、VD-X1 のメモリーカードスロットに市販の

無線 LAN カードを挿入し無線接続ができます。（使用できる無線 LAN カードについては、当社までお問い合わせ下さい。） 

あらかじめ PC 側のネットワーク設定と VD-X1 のネットワーク設定を合わせておいて下さい。 

PC 側のネットワーク設定は、MS Windows のネットワーク設定を参照して下さい。 

 

VD-X1 のネットワーク設定 

工場出荷時の IP アドレスは次のようになっています。 

 

本体側の Ethernet 使用時の IP アドレス 

IP アドレス:  192.168.0.10 

サブネットマスク:  255.255.255.0 

無線 LAN カード使用時のデフォルト IP アドレス 

IP アドレス:  192.168.1.10 

サブネットマスク:  255.255.255.0 

 

VD-X1 の IP アドレスを変更する方法は、次項の「6.3. VD-X1 との通信接続」に記載します。 

 

6.3. VD-X1 との通信接続 

PC にインストールされた VdRmt プログラムを使用して、VD-X1 との通信接続を行います。 

あらかじめ前項の「6.2. ネットワーク設定」にしたがって、IP アドレスを PC に設定して下さい。 

 

1. VD-X1 と PC を接続します。 

リアパネルの LAN コネクタ: 有線 LAN 100BASE-TX 

または、 

メモリーカードスロットに挿入された無線 LAN カード: 無線 LAN 

 

2. VD-X1 を起動します 

 

3. VdRmt プログラムのアイコンをダブルクリックしてプログラムを起動します。 

 

4. <VDRemote>が表示されます。 

 

5. メインバーにあるアイコン           をクリックします。 

 

<接続先デバイス>が表示されます。 

 

 

 

 

 

 

 

 

 

 

Page 15 



 

6. 接続可能な VD-X1 には IP アドレスのフィールドに緑色のフラグが表示されます。 

すでに他の PC から使用されている場合には、赤色のフラグが表示されます。この時、対象機器への

接続はできません。 

同一セグメントとして正しくない IP アドレス、あるいは VD-X1 のタイムアウト中など、TCP 接続できな

い場合にはグレーのフラグが表示されます。この場合、適切な IP アドレスの設定をしてから接続を行

って下さい。 

 

7. 接続を開始する VD-X1 の項目をクリックして選択します。クリックされた VD-X1 の項目が 

カーソル表示となります。 

 

 

 

 

 

8. [OK]をクリックすると<確認>が表示されます。 

[Rmt<-VD]をクリックすると、通信をオープンして、現在の VD-X1 の設定情報を VdRmt 
プログラムに取り込みます。 

[Rmt->VD]をクリックすると、通信をオープンして、現在の VdRmt プログラムの設定情報を 

VD-X1 に設定します。 

[キャンセル]をクリックすると、通信をオープンせず元に戻ります。 

 

9. PC と VD-X1 間の通信が行われている時は、VD-X1 の画面下部のステータス表示に 

<ON LINE>と点滅表示されます。 

 

 注意 
ネットワーク回線の問題で、3 分間 PC-VD-X1 間の通信が行われない場合には、VD-X1 は自動的に PC とのネットワーク接続を遮断しオフラインモードとな

ります。再接続を行って下さい。 

VdRmt プログラム接続中は、本体キー操作は行うことができません。 

 

6.4. VD-X1 の IP アドレスを変更する 

1. メインバーにあるアイコン           をクリックします。 

 

<接続先デバイス>が表示されます。 

 

2. 接続可能な VD-X1 には IP アドレスのフィールドに緑のフラグが表示されます。 

 

3. IP アドレスを変更する VD-X1 の項目をダブルクリックします。 

 

4. VD-X1 との接続を開始し<IP アドレス設定>が表示されます。 

変更する IP アドレスやサブネットマスクを入力し[OK]をクリックします。 

 

5. 変更後、必ず VD-X1 本体の電源を切り、再立ち上げを行って下さい。 
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第 7章 設定 
 

VD-X1 で収録を行うためには、各入力ポートの設定、モニター画面設定、収録ファイル名の設定などを行います。 

 

7.1. VD-X1 設定の手順 

新規、あるいは編集された設定を VD-X1 に反映する方法として次の方法があります。 

① 設定ファイルを PC 上の VdRmt プログラムで作成し、メモリーカードに保存、VD-X1 本体でその設定ファイルを読み込む。 

② VD-X1 と PC を通信で接続し、MiRmt プログラムから直接設定情報を書き換える。 

VD-X1 キー操作では、一部の機能のみの変更が可能です。基本の設定は VdRmt プログラムで行います。 

ここでは、①の設定ファイルを作成する方法に従って手順を説明いたします。 

 

7.2. 設定ファイルを VD-X1 で読み込む 

VdRmt プログラムを起動すると、<VDRemote>が表示されます。おおまかな流れを説明します。 

 

1. コントロールバーの選択項目から設定を行う項目をダブルクリックして必要な設定を行います。 
ポートが有効になると、緑色で表示されます。また、設定内容が項目の右側に表示さます。 
 

2. メインバーの        アイコンをクリックして設定情報をメモリーカードのルートディレクトリに保存します。 

 

3. 設定情報の書かれたメモリーカードを VD-X1 に挿入します。 

 

 注意 

VdRmt プログラムにより作成された設定ファイルは必ず、メモリーカードのルートディレクトリに保存して下さい。 

メモリーカードから設定ファイルを読み出す場合、VD-X1 で選択できるファイルの最大数は 15(カードの FAT 情報に書かれた

順)となります。16 個以上の設定ファイルをカードには書かないで下さい。 

 
 
 
 
 

 

VDRemote 設定項目 

 

コントロールバー 機能 

CAN  

CAN1 CAN1 ポート動作有効/無効、ボーレートの設定と収録シグナルの設定 

(CAN2) 上記同様 

A/D INPUT 収録の有効/無効、サンプリング周波数、チャネル数、入力レンジの設定、チャネル名、オフセット、係数設定 

REC FILE メモリーカード上のデータ保存先ディレクトリと収録ファイル Prefix 名の設定 

WINDOW  

DISPLAY 画面表示の割り付けパターン(4 四画面、2 画面、1 画面など)の選択 

WINDOW1 DISPLAY で割り付けられた位置に、どのポート(CAN、アナログ)の信号をモニター表示するか、およびその表示形式の設定 

(WINDOW2,3,4) 上記同様 

TRIGGER トリガの設定 

SYSTEM VD-X1 LCD のコントラストとパワーセーブモード(LCD 自動的に OFF)の設定、起動時オプションの設定、設定パラメータの保存と読み込み、VD-X1
時刻設定(通信中) 

REMOTE MONITOR PC でのリアルタイムモニターの有効/無効 
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4. [MENU]を押して<MENU>を表示します。 

 

5. VD-X1 上下キーでカーソル表示を[SYSTEM]に移動します 

 

 

 

 

 

 

 

 

 

 

6. [ENTER]を押すと、<SYSTEM SETTING>が表示されます。 

 

7. [上下左右]キーでカーソル表示を<Setting File> [LOAD]に移動します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

8. [ENTER]を押すと<FILE SELECT>が表示されます。 

 

9. カーソル表示を[SELECT]に移動して[ENTER]を押します。 

 

10. 表示されているファイル名の中から、設定を行うファイルをカーソル表示し[ENTER]を押しま

す。選択されたファイルが白で囲まれます。 

 

 

 

 

 

 

 

 

 

 

11. [OK]にカーソル表示を移動し、[ENTER]を押すと、<LOADING>に<Current setting 
will be over written.  Proceed with loading?>メッセージが表示されます。 
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12. [OK] を カ ー ソ ル 表 示 し [ENTER] を 押 す と <Information> に <Loading 
successfully!!>メッセージが表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

13. [OK]をクリックしてメッセージを確認し、<SYSTEM SETTING>を[OK]でぬけたときに設定

パラメータの変更を確定します。 

<Current Cnd.>に現在読み込まれた設定ファイル名が表示されます。 
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7.3. Wizard による設定 

VdRmt プログラムでは、設定操作を簡単に順序良く行うための Wizrad が用意されています。 

ここでは、Wizard の流れを説明します。各項目の設定内容の詳細については、「7.4. CAN ポートの設定」 以降を参照して下さい。 

 

 

メインバーの         をクリックすると設定 Wizard を起動します。 

 

設定 Wizard に沿って設定条件を入力することで簡単に設定ファイルを作成することができます。 

 

 

 注意 
設定 Wizard では、CAN ポート 1 のみ使用を前提としています。 

他の CAN ポートを使用する場合には、いったん Wizard を利用して設定を完了し、コントロールバーの各選択項目で必要な設定を行って下さい。 

また、作成された内容を編集する場合も、いったん Wizard を完了し、コントロールバーの各選択項目で必要な編集を行って下さい。 

Wizard でサポートしているデータベースは、CAN の場合、dbc ファイルとなります。 

 

設定 Wizard では次のフローで収録条件設定ファイルを作成することができます。 

 

1. <CAN 設定>では収録シグナルの選択を行います。 

 

 
 
 
 
 
 
 
 
 
2. <CAN 収録設定>で<シグナル収録>をチェックした状態で[DB 選択]をクリックすると、<ファイ

ルを開く>が表示されます。 

対象の CANdb を選択すると、VdRmt プログラムの<シグナル選択>が表示されます。収録対象

のシグナルを選択して下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

丸取り収録、または ID フィルタによる収録を行うには、<シグナル収録>のチェックをはずした状態で

[DB 選択]をクリックして下さい。<ID フィルタ>が表示されます。 
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3. 選択を終了して[次へ(N)>]をクリックすると、<AD 設定>に進みます。表示内容に従って必要

な設定を行って下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. 順次<ディスプレイ設定>、<ウィンドウ設定>、<ファイル設定>、<SYSTEM 設定>に進み

ます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. 最後に[確認]が表示されます。設定内容を確認後、[完了]をクリックすると<名前を付けて

保存>が表示され、Wizard で選択した内容を設定ファイルとして保存します。 
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7.4. CAN ポートの設定 

 

CAN を利用してデータを収録する場合、CAN ポートの設定を行います。 

ここでは CAN1 の設定例を説明しますが、他の CAN2 ポートも同様の設定です。 

 

CAN によるデータ収録について 

VD-X1 では、次のモードの CAN データ収録を行うことができます。 

① 丸取り: バスに流れている CAN ID フレームをすべて収録します。 

② ID フィルタ: 収録する ID フレームデータをあらかじめ指定して、指定された ID フレームだけ収録します。 

③ シグナル収録 : ID フレームの中の信号位置に配置されたデータを収録します。車両センサやアクチュエータなどのデータを物理値やフラグ情報として使用

できます。 

 

7.4.1. VdRmt プログラムによる設定 

1. コントロールバーの選択項目から、 [CAN1] をダブルクッリクします。<ポート設定>が表示さ

れます。 

CAN1 での収録を有効にするには、<有効/無効>で[有効]を選択し、<ボーレート>を設定します。 
ポートの<有効/無効>、[有効]で収録対象となります。  

ボーレートの設定 

ボーレートが選択されると自動的に最適なパラメータが選択されます。手動での表示されているパラメー

タ入力、または下段の選択対象をクリックして変更を行うこともできます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. シグナル収録を行うか行わないかを選択します。 

シグナル収録を行う場合は、<シグナル収録を行う>のチェックボックスにチェックを付けます。 

シグナル収録を行わない場合は、チェックボックスのチェックをはずします。(丸取り収録、ID フィルタ収

録の場合) 

 

 

Page 22 



VD-X1 User’s Manual 
第 7章 設定 

3. <シグナル収録を行う>の右の、               をクリックします。 

 

i. シグナル収録を行う場合 
<収録シグナル>が表示されます。 

収録シグナルはポートあたり最大 32 個選択することができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
ii. シグナル収録を行わない場合 

<ID フィルタ>が表示されます。 

丸取り収録の場合は、<丸取り収録を行う>のチェックボックスをチェックします。 

以上で丸取りの場合の設定は終了です。 

 

ID フィルタ収録の場合は、<丸取り収録を行う>のチェックボックスのチェックをはずします。 

下記の画面が表示されます。ダイアログ右側のボタンがアクティブになります。 

ID フィルタはポートあたり最大 32 個使用することができます。 

 

 注意 

後述する DCAN 設定の結果、使用される ID フィルタ数が 32 を超えると該当ポートの CAN 収録を

無効とします。この場合、ID またはシグナルを減らしてから[有効]に戻してください。 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
4. 次に収録対象のシグナルや ID を設定します。 

 

i. シグナル収録の場合 
読み込むデータベースがなく、手入力を行う場合は、<収録シグナル>で[追加]をクリックして<

シグナル設定>を表示します。 

CAN ID フレーム中のシグナルの設定を行います。ここで設定されたシグナル(最大 32/ポート)が収録

対象となります。 

表示される各パラメータを入力後、[設定]をクリックして入力を確定します。 

収録対象とするすべてのシグナル入力後、<収録シグナル>の[OK]をクリックして設定を完了しま

す。 
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データベースから設定を行う場合は、<収録シグナル>で[DB から追加]をクリックします。 
 

 注意 

対応しているデータベースファイルは、CANdb(*.dbc ファイル)です。 

 

[DB から追加]をクリックすると<ファイルを開く>が表示され、読み込むデータベース(DB)ファイルを

選択します。 

DB ファイルが読み込まれると、<シグナル選択>が表示され、シグナル名による収録シグナルへの設

定ができます。 

<+>の表示のある項目をクリックすると、その ID に割り付けられている各シグナルを表示します。 

 

 

<DB リスト>に表示されているシグナル一覧から収録対象のシグナルをクリックで選択し、[>>]ボタン

をクリックすると<収録シグナル>にそのシグナルが登録されます。 

<収録シグナル>に登録されたシグナルは、<DB リスト>の表示から削除されます。 

ここで登録される順に VD-X1 本体での、SIGNAL 表示や DIGITAL 表示の選択順となります。 

<収録シグナル>に表示されたシグナルをクリックし(複数選択が可能)、[<<]ボタンをクリックすると、

登録が解除されます。 

 

収録対象のシグナルをすべて選択したら、[OK]をクリックして設定を完了します。 

 

 
 
 
 
 
ii. シグナル収録を行わない場合 ‐ ID フィルタによる収録 
ID フィルタによる収録を行う場合は、<ID フィルタ>で<丸取り収録を行う>のチェックをはずします。

収録対象の ID を表示されているテーブルに入力します。 

 

 

 

 

 

 

 

 

 

 

<ID>列にカーソルをおきダブルクリックすると収録対象の ID の入力ができます。 

16 進(0x...)で ID を入力します。10 進で入力した場合は、自動的に 16 進となり表示されま

す。ただし、右下の[10 進表示]ボタンが押されている場合は、10 進表示となります。 

[10 進表示]をクリックすると、ボタンが押し込まれた表示となります。入力された ID が 10 進表示となり

ます。もう一度クリックするとボタンが元に戻り、16 進表示に戻ります。  

 

 

収録する ID を入力したら[OK]をクリックして設定を完了します。 

 

5. 設定されたシグナルや ID は次の手順で編集できます。 

 

収録シグナルの編集 

編集を行いたいシグナルをクリックし[編集]をクリックすると、<シグナル設定>が表示され設定された

パラメータの編集が可能です。 

[削除]をクリックするとそのシグナルを削除します。複数シグナルを選択して削除することもできます。 

[クリア]ではすべてのシグナルを削除します。 

 

ID フィルタの編集 

削除を行いたい ID をクリックし[消去]をクリックすると、<ID フィルタ>で設定された ID の削除が可能

です。[クリア]では入力されたすべての ID を削除します。 
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7.4.2. VD-X1 操作キーによる設定 

[MENU]を押して、メニューを表示します。 

[CAN]をカーソル表示して[ENTER]を押すと、[CAN1]～[CAN2]が表示されます。 

[CAN1]をカーソル表示して[ENTER]を押すと<CAN PORT SETTING>が表示されます。 

 

 

 

 

<Port>にカーソル表示を移動し[ENTER]を押す

と、ポートの有効[Enable]/無効[Disable]の選択

ができます。 
<Baudrate>にカーソル表示を移動し[ENTER]を押すと、

ボーレートの選択ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[DETAIL]にカーソル表示を移動し[ENTER]を押すと、パラ

メータの詳細設定ができます。 
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[FILTER]にカーソルを移動し[ENTER]を押すと ID フィルタの設定ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

VD-X1 の[SHIFT]を押すと、表示が<DEC>(10 進)/<HEX>(16 進)に切り替わります。 

[ADD]をカーソル表示し[ENTER]を押すと次の入力パネル(<HEX>が選択された場合)が表示され、フィルタリングを行う ID(収録対象の ID)の入力が、最大

32 個までできます。 
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7.5. アナログ入力の設定 

VD-X1 では、8 チャネルのアナログ信号を入力できます。 

 

7.5.1. VdRmt プログラムによる設定 

1. コントロールバーの選択項目から、[A/D INPUT]をダブルクッリクします。<アナログ収録>が表

示されます。アナログ信号の収録を有効にするには、<アナログ収録>で[有効]を選択します。 [有効]で収録対象となります。 

 

 

 

 

 

 

 

 

 

 

 

[OK]をクリックすると変更が確定します。 

 

2. チャネルの詳細を設定するには、設定するチャネルをダブルクリックします。 

<AD チャネル設定>が表示されます。 

<Range>では入力レンジ(± 1V/2 V/5 V/10 V)を選択、<Name>ではチャネル名、<Unit>では

スロープ係数、<Offset>ではオフセット値を入力することができます。 

 

 

 

 

 

3. [OK]をクリックすると設定が確定します。 

 
7.5.2. VD-X1 操作キーによる設定 

[MENU]を押して、メニューを表示します。[A/D]をカーソル表示して[ENTER]を押すと、<A/D SETTING>が表示されます。 

収録するチャネル数を選択します。 

8 ch/4 ch/2 ch/1 ch 

サンプリング周波数を選択します。 

1 kHz/500 Hz/200 Hz/ 

100 Hz/50 Hz/20 Hz/ 

10 Hz/5 Hz/2 Hz/1 Hz 

<Mode>にカーソル表示を移動し

[ENTER]を押すと、収録の有効

[Enable]/無効[Disable]の選択

ができます。 

<ActiveCh> にカーソル表示を移動し[ENTER]を押すと、収録

チャネル数の選択ができます。 

<Sampling>にカーソル表示を移動し

[ENTER]を押すと、サンプリング周波

数の選択ができます。 

カーソル表示を各チャネルに移動し

[ENTER] を 押 す と 、 <CH
SETTING>が表示されます。 

る

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 注意 

VD-X1 本体操作で AD 設定を変更した場合は、AD データの WINDOW 表示がデフォルトとな
<ASCII INPUT>パネルが表示されチャネル名や

物理量単位の設定行います。カーソル表示によ

選択と[ENTER]で入力します。 

 

ります。 

Page 27 



 

7.6. 収録ファイル名の設定 

VD-X1 で収録されたデータはメモリーカードに収録されます。 

この設定では、メモリーカード上に収録データを保存するためのディレクトリ名、およびファイル名を設定することができます。 

 

メモリーカード上のデータファイルについて 

z ロングファイル名の使用が可能です。 

z 設定されたファイル名を Prefix として、VD-X1 は自動的に 00001 から始まる連番を付けデータファイル名とします。同じファイル名 Prefix のデータがカー

ドに存在するときは、その次の連番を取得しデータファイルを生成します。また、99999まで連番が使用された場合は、00000を用いて、このファイルに常

に上書きを行います。 

z この連番は、収録の開始・終了ごとに一つの番号がインクリメントされます。 

z データファイルの拡張子は、MBD です。 

 

 注意 

ファイル名、ディレクトリ名とも日本語には対応していません。 

 

 

7.6.1. VdRmt プログラムによる設定 

1. コントロールバーの選択項目から、[REC FILE]をダブルクッリクします。<ファイル設定>が表

示されます。 

保存先のメモリーカード上のディレクトリ名を設定します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. [OK]をクリックして設定を確定します。 

 

 

7.6.2. VD-X1 操作キーによる設定 

[MENU]を押して、メニューを表示します。 

[FILE]をカーソル表示して[ENTER]を押すと次の表示となります。 

 

 

 

 

 

 

 

 

 

 

 

 

<REC FILE>をカーソル表示し[ENTER]を押すと<SETTING>が表示されます。 

収録ファイル名を設定します。ここで設定されたファイル名の後ろに 00001 から始まる 5 桁の数字

が付加されたものが実際のデータファイル名となります。ファイル名などの入力文字数制限は、

「10.3. 補足」を参照して下さい。 

<Card>には現在メモリーカードが挿入されているスロット位置を表示します。 

<Dir>にカーソル表示を移動し[ENTER]を押すと、[Input]または[Select]の選択が

できます。 

[Input]で[ENTER]を押すと<ASCII INPUT>が表示されカーソル表示と[ENTER]
によりディレクトリ名の入力ができます。 

[Select]では<DIR SELECT>が表示され、あらかじめメモリーカードに書かれたディレ

クトリ間で収録ファイルの保存先ディレクトリの移動ができます。 

<Dir>と同様の操作で、

<File>ではファイル名の設

定を行うことができます。 

収録ファイルに対するコメントを入力することができます。 

半角英数字で 255 文字まで、ここで入力された内容は各データファイルのヘッダに記述されます。
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7.7. モニター表示設定 

VD-X1 の LCD 画面にどのポートの信号のモニター表示を行うかの割付を行います。 

 

7.7.1. VdRmt プログラムによる設定 

1. コントロールバーの選択項目から[DISPLAY]をダブルクリックします。<ディスプレイ設定>が表

示されます。 

<ディスプレイタイプ>では、画面表示モードを選択します。4 画面表示、上下 2 画面表示、左右

2 画面表示、1 画面表示モードが選択できます。 

<ウィンドウ選択>では、[WINDOW1]～[WINDOW4]メニューで設定される、どの表示を割り付け

るかを設定します。表示される[1]～[4]がそれぞれ WINDOW1～WINDOW4 に対応します。 

 

4 画面表示が選択された場合の、VD-X1 本体における各[WINDOW]メニューとの関係を示しま

す。 

 

 

 

 

 WINDOW1 WINDOW2 
 

 

 

 

 

 

WINDOW3 WINDOW4  

 

 

 

 

 

 

 
ここでは WINDOW1 の設定例を説明しますが、WINDOW2～WINDOW4 も同様の設定です。 

 

2. [WINDOW1]をダブルクッリクします。<ウィンドウ設定>が表示されます。 

ここで表示される内容は、選択された<表示ポート>と<表示モード>により異なります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. [表示ポート]では、現在選択された WINDOW(この例では WINDOW1 にどのポートのデータを

表示するか選択します。 

表示ポートとして選択できる内容は、CAN1、CAN2、A/D、STATISTIC のいずれか一つです。 

データを表示するためには選択されたポートが、[有効]になっていることが必要です。 
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4. 選択された[表示ポート]と[表示モード]の組み合わせは次のとおりです。 

 

CAN1～CAN2 が選択された場合 

HEX TRACE: 表示位置を固定してデータ表示              

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

HEX FLOW: スクロールイメージでデータ表示 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CAN GRAPH: シグナル収録されたデータをグラフ表示 

 

 

 

 

 

 

 

P

4 つの時間軸グラフを表示します。(<ライン 1>～<ライン 4>) 

<シグナル>では表示するシグナル名を選択します。 

<描画色>ではグラフ表示のラインの色を選択できます。 

グラフ上の Y 軸スケールは、シグナル設定時の最大値、最小

値となります。 

<横軸スケール>ではグラフ表示時間軸の設定を行います。 

１０秒、1 分、5 分、10 分の選択ができます。 
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CAN SIGNAL: シグナル収録されたデータを選択して表示 

 

 
<表示>には、収録対象として選択されたシグナル名が表示

されます。非表示とするシグナルをクリックしてカーソル表示を

行い、[→]をクリックすると<非表示>に移動し表示対象から

除外されます。 

 

モニター時、表示されるシグナルの順番は、設定ダイアログで

選択されたシグナル順となります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CAN DIGITAL: シグナル収録されたデータをディジタルパネルイメージで表示 

 

 
<ディジタル表示>には、収録対象として選択されたシグナ

ル名が表示されます。非表示とするシグナルをクリックしてカ

ーソル表示を行い、[→]をクリックすると右のスペースに移動

し表示対象から除外されます。 

 

モニター時、表示されるシグナルの順番は、設定ダイアログ

で選択されたシグナル順となります。 

 

ディジタルパネルは小数点を除く最大 10 桁の表示です。 

シグナルをクリックしてカーソル表示を行い、ダイアログ下部

の<整数桁>、<小数桁>で表示桁数を選択し、[設定]を

クリックすると表示桁数の選択が可能です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A/D が選択された場合 

BAR METER、GRAPH、または DIGITAL 表示となります。 
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STATISTICS が選択された場合 

STATISTICS(CAN バス統計)表示となります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.7.2. モニター表示画面例 

モニター表示パターンの画面例を示します。 

 

 

 

 

 
H R E  
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7.7.3. VD-X1 操作キーによる設定 

[MENU]を押して、メニューを表示します。 

[DISPLAY]をカーソル表示して[ENTER]を押すと、<DISPLAY SETTING>が表示されます。 

 

 

 

 

 

 

<Window>は<Type>で 4 画面表示以

外が選択されたときに有効となります。 

選 択 さ れ た 分 割 表 示 画 面 に 、 次 の

WINDOW1～WINDOW4 で設定されたど

のWINDOWを割り付けるかの設定を行い

ます。 

なお、WINDOW1～WINDOW4 は 4 画面

表示が選択された場合、下記に示す位

置に表示される WINDOW です。 

画面分割のパターンを選択します。 

1 : 1 画面表示 

Horiz2 : 上下 2 画面表示 

Vert2 : 左右 2 画面表示 

4 : 4 画面表示 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

WINDOW1 WINDOW2  

 

 

 

 

 

 

 
WINDOW3 WINDOW4  

 

 

 

 

 

 

次に各 WINDOW の設定を行います。 

[WINDOW]をカーソル表示して[ENTER]を押すと、[WINDOW1]～[WINDOW4]が表示されま

す。 

[WINDOW1]をカーソル表示して[ENTER]を押すと<WINDOW SETTING>が表示されます。 

 

[Port]にカーソル表示を移動し[ENTER]を押すと、表示を行うポートの選択ができます。 

 

[Type]にカーソルを移動し[ENTER]を押すと、先に選ばれた表示ポートに対応した表示モードの選

択ができます。 

 

<Port>が [CAN]の選択では、[FLOW]または[TRACE]への変更のみ有効です。 

<Port>が[A/D]の選択では、[BAR METER]、[GRAPH]、または[DIGITAL]への変更のみ有効

で、[GRAPH]では先頭の 4ch 分の固定表示となります。 
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7.8. トリガ条件の設定 

VD-X1 では、トリガ収録を行うことができます。 

トリガ条件の設定は、VdRmt プログラムのみで行うことができます。 

アナログ入力を含むすべての収録シグナルや項目がトリガ対象として選択できます。 

 

7.8.1. VdRmt プログラムによる設定 

1. コントロールバーの選択項目から、[TRIGGER]をダブルクッリクします。 

<トリガ設定>が表示されます。 

 

<トリガ基本設定>には次のパラメータを設定します。 

項目 内容 

動作モード OFF: 手動での収録スタート・ストップ(トリガ機能を用いない、通常の収録) 

トリガ収録: 設定されたトリガ条件による収録を行う 

繰り返し収録 最大 32768 回、0 と 1 では一回のみ収録 

プリトリガ時間 最大設定時間 120 秒 (ただしバッファサイズ 16MB 以内) 

ポストトリガ時間 最大設定時間 32768 秒 0 秒では、STOP キーにて収録停止 

 

 

 

 

2. トリガ条件を設定します。 

画面中央部分でトリガ監視対象の各シグナル・収録項目の成立条件を設定し、画面下部でこれ

ら設定された中から最大 4 シグナル・収録項目を 1 つのグループとし条件設定を行います。グループ

内では AND または OR条件の選択ができます。 

グループ間では OR条件となります。 

設定したシグナル・収録項目をクリックしてカーソル表示で選択、PC の[Delete]を押すと、その設定

が削除されます。 

複数選択は、Windows の[Shift] + [矢印キー]、または、[Ctrl] + [左クリック]が利用できます。 

 

 注意 

トリガ設定対象は、CAN(シグナル収録)/アナログの組み合わせとなります。検知方式はエッジですが、

REC スタンバイ時にすでにトリガ条件となっていた場合は、最初のトリガはレベル検知として動作し、

すぐにトリガ成立として収録を開始します。 

[FWD]キー(収録開始)、[STOP]キー(収録停止)、メディアフル(収録停止)が先に成立した場合は、

これらの動作が優先されます。 

CAN の場合、トリガ収録の対象はシグナル収録のみとなります。 

 

トリガ設定例 

CAN1 ポート(PORT)で収録されるシグナルの中の、EngnTemp(SIGNAL)が 50degC(Value)を最初

に(COUNT)超える(Cond.)、または EngSpeed が 1000rpm を 2 回目(COUNT)に超える条件を GrpA

とします。 

CAN1 ポートで収録されるシグナルの中の、EngnTemp が 50degC を最初に超えて、かつ CAN2 ポー

トで収録されるシグナルの中の CarSpeed が 30km/h を最初に超える条件を GrpB とします。 

GrpA または GrpB のどちらかの条件が成立したときにトリガをかけます。 

プリトリガ 60 秒、ポストトリガ 30 秒の収録を 2 回行う場合の設定例です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Page 34 



VD-X1 User’s Manual 
第 7章 設定 

7.9. システムの設定 

VD-X1 の、LCD のコントラストやパワーセーブモード(LCD 表示 OFF)、キービープ、また、時刻設定を行うことができます。 

 

7.9.1. VdRmt プログラムによる設定 

1. コントロールバーの選択項目から、[SYSTEM]をダブルクッリクします。<SYSTEM 設定>が表

示されます。 

項目 内容 

コントラスト LCD のコントラストの設定 

LCD セーブ VD-X1 へのキー入力が無い状態が続くときに、LCD のバックライトを消灯しパワーセー

ブモードに入る時間の設定 

キービープ キー入力時に、ビープ音を出すか(有効)、出さないか(無効)の選択 

BootOnREC 電源 ON でシステム起動後、自動的に REC スタンバイ状態に([REC]キーの押された

状態) 

DirectREC REC スタンバイ状態になると自動的に REC 状態(収録状態)に 

(BootOnREC と組み合わせることで、電源 ON でシステム起動後、自動的に収録状

態に) 

自動設定ロード システム起動時に、メモリーカードにあらかじめ保存された設定ファイル(CND ファイル)を

読み込み、その内容にしたがって本体の設定を変更(ただし、この機能はメモリーカード

に設定ファイルが一つだけ保存されていることを条件とし、複数設定ファイルが保存され

ている場合、設定ファイル選択画面の表示となる) 

間引きモード 設定された時間ごとにその直後のデータのみ保存。 

ファイル名表示 収録開始時、または収録中に[SHIFT]キーが入力されたときに VD-X1 の LCD 右下

に表示するファイル情報ウィンドウの表示時間を設定します。 

時刻設定 VD-X1 との通信中に有効となります。<ローカル PC 時間をセット>にチェックをすると

入力された年月日と時刻が VD-X1 に設定されます。 

 

 注意 
DirectREC 有効では、REC スタンバイ状態に入ると自動的に REC 状態(収録状態)となります。し

たがって、トリガによる収録を開始する場合は、必ず DirectREC は無効にして下さい。 

 

2. [OK]をクリックすると選択された設定が確定します。 

 

7.9.2. VD-X1 操作キーによる設定 

[MENU]を押して、メニューを表示します。 

[SYSTEM]をカーソル表示して[ENTER]を押すと、<SYSTEM SETTING>が表示されます。前

項を参考に、必要な設定を行って下さい。 

 

 

 

 

 [CLOCK]をカーソル表示して[ENTER]を押すと時刻設定ができます。 
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7.10. 設定情報の保存 

設定された内容を、設定ファイル(xxx.CND)として保存します。 

VD-X1 では、メモリーカードに保存された設定ファイルを読み込み、設定内容の変更を行うことができます。 

 

 注意 
VdRmt プログラムにより作成された設定ファイルは必ず、メモリーカードのルートディレクトリに保存して下さい。 

メモリーカードから設定ファイルを読み出す場合、VD-X1 で選択できるファイルの最大数は 15(カードの FAT 情報に書かれた順)となります。 

16 個以上の設定ファイルをカードには書かないで下さい。 

 

7.10.1. VdRmt プログラムによる保存 

1. メインバーの         アイコンをクリックします。 

 

<名前を付けて保存>が表示されます。 

 

 

 

 

 

 

 

2. <保存する場所(I)>には、設定ファイルを保存するドライブ名とディレクトリ名を選択します。 

VD-X1 から読み込んで設定を行うためにメモリーカードに設定ファイルを保存する場合には、使用す

るメモリーカードのルートディレクトリを選択します。 

 

3. <ファイル名(N)>に設定ファイル名を入力し、[OK]をクリックすると設定内容が保存されます。 

 

7.10.2. VD-X1 操作キーによる保存 

[MENU]を押して、メニューを表示します。 

[SYSTEM]をカーソル表示して[ENTER]を押すと、<SYSTEM SETTING>が表示されます。 

<Setting File>の[SAVE]にカーソル表示を移動し[ENTER]を押すと<SAVE SETTING>が表

示されます。 

 

 

 

 

 

 

 
カーソル表示を<Name>に移動し[ENTER]を押すと<ASCII INPUT>が表示され保存フ

ァイル名の入力ができます。ファイル名などの入力文字数制限は、「10.3. 補足」を参照し

て下さい。 

 

 

 

 

 

 現在 VD-X1 にロードされている設定ファイル名が表示されます。 
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7.11. 設定情報の読み込み 

保存された設定ファイルから設定内容を読み込み、現在の設定内容を変更します。 

VD-X1 では、メモリーカードに保存された設定ファイルを読み込み、設定内容の変更を行うことができます。 

 

7.11.1. VdRmt プログラムに読み込み 

1. メインバーの         アイコンをクリックします。 

 

<名前を付けて保存>が表示されます。 

 

 

 

 

 

 

2. <ファイルの場所(I)>には、読み込む設定ファイルの存在するドライブ名とディレクトリ名を選択

します。 

 

3. 読み込むファイルを<ファイル名(N)>で選択し、[OK]をクリックすると設定内容が VdRmt プロ

グラムに読み込まれます。 

 

7.11.2. VD-X1 操作キーによる読み込み 

1. [MENU]を押して、メニューを表示します。 

 

2. [SYSTEM]をカーソル表示して[ENTER]を押すと、<SYSTEM SETTING>表示されます。 

 

3. <Setting File>の[LOAD]にカーソル表示を移動し[ENTER]を押します。 

 

4. <FILE SELECT>が表示されます。 

 

5. カーソル表示を[SELECT]に移動して[ENTER]を押します。 

 

6. 表示されているファイル名の中から、設定を行うファイルをカーソル表示し[ENTER]を押します。

選択されたファイルが白で囲まれます。 

 

7. [OK]にカーソル表示を移動し、[ENTER]を押すと、<LOADING>に<Current setting will 
be over written.  Proceed with loading?>のメッセージが表示されます。 

 

8. [OK]をカーソル表示し[ENTER]を押すと<Information>に<Loading successfully!>メ

ッセージが表示されます。 

 

9. [OK]クリックしてメッセージを確認し、<SYSTEM SETTING>を[OK]でぬけたときに設定パラ

メータの変更を確定します。 
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Note: 
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第 8 章 収録・表示再生 
 

ここでは VD-X1 本体のキー操作によるメモリーカードへのデータの収録とデータ再生動作について説明します。 

また、VdRmt プログラムからのリモート収録操作についても説明します。 

 

8.1. 使用できるメモリーカードについて 

VD-X1 で使用するメモリーカードはあらかじめ FAT16 または FAT32 でフォーマットされたメモリーカードで、当社で検証済みのカードをご使用下さい。 

対応カード: コンパクトフラッシュタイプメモリーカード(カードアダプタ要) (株)ハギワラシスコム Z-pro シリーズ (128MB ～ 2GB)  (2005 年 10 月現在) 

 

8.2. メモリーカードの挿入とイジェクト 

VD-X1 では、メモリーカードが挿入され、LCD のステータス表示が<DRIVE READY>の状態で収録が開始できます。 

メモリーカードが挿入されていない状態では、REC STANDBY 状態に移行しません。 

VD-X1 に挿入されたメモリーカードをイジェクトするためには、 

1. VD-X1 を<READY>状態にします。([STOP]の LED が点灯。) 

 

2. [MENU]を押します。 

 

3. [EJECT]をカーソル表示し、[ENTER]を押します。 

 

4. <EJECT>が表示され、メモリーカードがアンマウントされたことを示します。 

 

 

5. [OK]にカーソル表示があるので[ENTER]を押します。 
 

6. メモリーカードを VD-X1 から取り出します。 

 

8.3. VD-X1 メイン画面の説明 

VD-X1 メイン画面の下部には、システムの状態が表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

システムの状態 

ドライブの状態 

収録経過時間(READY 状態のときは直前の収録時間) 

メディア残量 

システム時間 

収録中に[SHIFT]を押すと、画面右下にファイル情

報ウィンドウが表示されます。ファイル情報の表示時

間は、システム設定の<ファイル名表示>で選択で

き ま す 。 表 示 中 、 設 定 さ れ た 表 示 時 間 内 に

[SHIFT]をもう一度押すと表示が消えます。 

ファイル表示ウィンドウでは、収録ファイル名、トリガ

成立項目、EVENT 回数が表示されます。 

ファイル情報表示ウィンドウの表示時間の設定は

「7.9. システムの設定」を参照してください。 
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8.4. 収録する 

VD-X1 本体の操作キーにより、あらかじめ設定された条件にもとづき、メモリーカードへの収録を行います。 

 

 注意 
データ保存の可能なメモリーカードが VD-X1 本体に挿入されていない場合、収録モードに入ることができません。 

 

基本収録操作 

VD-X1 は、収録の開始から終了で 1 つのデータファイルを作成します。 

操作手順 VD-X1 システムステータス VD-X1 ドライブステータス 説明 

 READY NO MEDIA  

メモリーカード挿入 READY DRIVE READY メモリーカードを認識 

[REC]を押す REC STANDBY DRIVE READY 
[FWD]を押す REC DRIVE READY 収録開始 ⇒ 収録中 

[STOP]を押す READY DRIVE READY 収録終了 ⇒ 停止状態 

    

    

    

収録開始待機状態 

 

[PAUSE]押しでファイルをクローズし、REC STANDBY 状態になります 

操作手順 VD-X1 システムステータス VD-X1 ドライブステータス 説明 

 READY NO MEDIA  

メモリーカード挿入 READY DRIVE READY メモリーカードを認識 

[REC]を押す REC STANDBY DRIVE READY 収録開始待機状態 

[FWD]を押す REC DRIVE READY 収録開始 ⇒ 収録中 

[PAUSE]を押す 

または 

[REC]を押す 

REC STANDBY DRIVE READY 収録終了 ⇒ 収録開始待機状態 

[FWD]を押す REC DRIVE READY 収録開始 ⇒ 収録中 

[STOP]を押す READY DRIVE READY 収録終了 ⇒ 停止状態 

    

この操作では、収録ファイルが 2 つできます。 

 

トリガ収録 

設定されたトリガ条件で収録を行うためには、VD-X1 の[REC]を押して REC STANDBY 状態にし、トリガ待ちの状態にします。 
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8.5. 表示再生する 

収録データを VD-X1 で表示再生して確認することができます。 

 

 注意 

最後の収録が行われた後で、電源を OFF、画面設定条件を変更、またはメモリーカードをいったん取り出して再度挿入した場合は表示再生を行うことがで

きません。 

再生データの表示時間間隔は、収録時のタイミングではありません。 

長時間収録されたファイルの再生は、収録開始から 10 分までの範囲に限定されます。 

 

最後に収録されたファイルを再生するには 

1. VD-X1 を停止状態(<READY><DRIVE READY>の表示、[STOP]の LED が点灯)にし

[FWD]を押します。 

 

2. 最後に収録されたファイルのデータを開始ポイントから表示を行います。 

 

表示再生を行うファイルを選択して再生するには 

1. VD-X1 を停止状態(<READY><DRIVE READY>の表示、[STOP]の LED が点灯)にしま

す。 

 

2. [MENU]を押して、メニューを表示します。 

 

3. [FILE]をカーソル表示して[ENTER]を押します。 

 

4. [REPFILE]にカーソル表示を移動し[ENTER]を押します。 

 

5. <FILE SELECT>が表示されます。 

 

6. カーソル表示を[DIR]に移動して[ENTER]を押すと表示再生を行うファイルが保存されたフォ

ルダをカーソル表示で選択することができます。 

 

7. フォルダを選択後、[ENTER]を押すと、そのフォルダに保存されているファイル一覧が表示され

ます。 

 

8. カーソル表示を[FILE]に移動して[ENTER]を押すとファイル一覧の中から表示再生対象のフ

ァイルを選択することができます。 

 

9. カーソル表示を再生対象のファイルに移動して[ENTER]を押すとファイルが白で囲まれて表示

されます。 

 

10. カーソル表示を[OK]に移動して[ENTER]を押すと、選択したファイルの表示再生を開始し

ます。 

 

 注意 
電源を OFF、画面設定条件を変更、またはメモリーカードをいったん取り出したような場合は、ファイ

ル一覧のところに<NO FILE!>と表示され、再生を行うことができません。 

 

 

Page 41  



 

8.6. 最終収録ファイルを削除する 

VD-X1 本体のキー操作で最終収録ファイルの削除を行うことができます。 

1. [MENU]を押して、メニューを表示します。 

 

2. [FILE]をカーソル表示して[ENTER]を押します。 

 

3. [DELETE]をカーソル表示して[ENTER]を押します。 

 

4. 最終収録ファイルが削除可能な場合は、次のメッセージが表示されます。[OK]をカーソル表

示し[ENTER]を押すとファイルの削除を行います。 

 

 

 

 

 

 

5. 削除可能なファイルがない場合は、次のメッセージが表示されます。 

 

 

 

 

 

 

 

 

8.7. フォーマットする 

VD-X1 本体のキー操作でメモリーカードのフォーマットを行います。 

1. [MENU]を押して、メニューを表示します。 

 

2. [SYSTEM]をカーソル表示して[ENTER]を押します。 

 

3. [FORMAT]をカーソル表示して[ENTER]を押します。 

 

4. <CARD FORMAT>が表示されます。 

 

 

 

 
メモリーカードがセットされたカードスロット番号が表示されます。 

 

 

 

 

 

 

 

 

 

5. [
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カーソル表示し[ENTER]を押すとボリューム名をつけることができます。ファイル名などの入力文字数

制限は、「10.3. 補足」を参照して下さい。
カーソル表示し[ENTER]を押すと FAT16 か FAT32 によるフォーマットを選

択することができます。 

 

OK]をカーソル表示し[ENTER]を押すとフォーマットを開始します。 
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8.8. PC からリモート操作する 

VdRmt プログラムを用いて VD-X1 をリモート操作し、収録の開始や停止、PC 上でリモートモニターを行います。 

 

8.8.1. VD-X1 のリモート操作 

1. 「6.3. VD-X1 との通信接続」に従って PC と VD-X1 を LAN で接続します。 

 

2. メインバーの[REC]が有効になります。 

 

 

 

 

 

3. [REC]をクリックすると VD-X1 が REC スタンバイ状態になります。 

 

4. [FWD]        をクリックすると VD-X1 メモリーカードへの収録を開始します。 

 

5. [STOP]        をクリックすると収録を停止します。 

 
8.8.2. PC 上でのリモートモニター 

リモートモニターは、VD-X1 本体に設定された表示内容をリモートの PC 上で表示するものです。リモート表示可能な本体の表示モードはグラフ表示のみで

す。 

1. コントロールバーの選択項目から[REMOTE MONITOR]をダブルクリックします。 

 

2. <波形表示画面設定>が表示されます。 

 

3. <有効/無効>で[有効]を選択し、[OK]をクリックします。 

 

4. 「6.3. VD-X1 との通信接続」に従って PC と VD-X1 を LAN で接続します。 

 

 

5. 接続を完了するとモニター画面が表示されます。 

 

 

 

 

 

 

 

 

 

 

 

6. REC スタンバイ状態にするとモニターを開始します。 
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8.9. 収録データを PC に転送する 

VdRmt プログラムを用いて、メモリーカードに収録されたデータを PC に転送します。 

1. 「6.3. VD-X1 との通信接続」に従って PC と VD-X1 を LAN 接続します。 

 

2. ツールバーの          をクリックします。 

 

 

 

 

 

 

 

 

 

3. <ファイル転送>が表示されます。 

収録ファイルのあるディレクトリを選択すると、収録ファイルの一覧が表示されます。 

PC に転送する収録ファイルにチェックをつけます。 

[Shift] + [矢印キー]、[Ctrl] + [左クリック]で複数ファイルの選択、右クリックで選択された複数

ファイルを一括してファイル転送の[有効]/[無効]の操作ができます。 

 

<保存先>では、PC 上の転送先フォルダを選択することができます。 

 

 

 

 

 

 

 

4. [ダウンロード]をクリックすると選択されたファイルの転送を開始します。 

 

 注意 

転送先フォルダに同じファイル名がある場合、上書きされますのでご注意下さい。 
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第 9章 ビュワープログラムの操作 
 
本章では、VD-X1 に付属の波形表示プログラム VdView の使い方について説明します。 

VD-X1 で収録されたファイルは、付属の VdRmt プログラムで PC に転送、または、メモリーカードから PC にコピーすることができます。 

ここでは VdView プログラムを用いて、VD-X1 で収録されたデータファイル(MBD ファイル)を PC 上に再生表示する方法を説明します。 

 
9.1. プログラムのインストールと起動・終了 

 
 
9.1.1. VdView プログラムのインストール 

 

 注意 

VdView プログラムの動作環境は、VdRmt プログラムの動作環境に準じます。 

ただし、より多くのメモリーを搭載することで画面に表示できる時間範囲を広くすることができます。 

 

1. 付属の CD の中の、VdView フォルダにあるすべてのファイルをご使用になる PC のワーキングデ

ィレクトリにコピーして下さい。 

 

2. ディレクトリには、左記のアイコンが作成されます。 

 
9.1.2. プログラムの起動・終了 

1. VdView アイコンをダブルクリックするとプログラムを起動します。 

<Open>ダイアログが表示され、データ表示を行うファイルが選択できます。 

 

2. プログラムを終了するには、<Open>ダイアログを閉じた後で、ウィンドウ右上の        をクリ

ック、または、メニューバーの[File] ⇒ [Exit]をクリックします。 

 

 

 

 

 

 

 
 

9.1.3. 表示するファイルを開く 

1. 起動時に表示された<Open>ダイアログでファイルを選択するか、[File] ⇒ [Open...]をクリッ

クして<Open>ダイアログを表示しファイルを選択します。 

 

2. ファイルを選択し、[開く(O)]をクリックすると波形表示ウィンドウが表示されます。 
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9.2. 波形表示ウィンドウでの基本操作 

 
9.2.1. 基本操作 

波形表示ウィンドウでは次の操作ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

メニューバー 

File: ファイルを開く、ファイルエキスポート(データ切り出し)、プリントアウトなど 

Edit: ズーム、ズームアンドゥ 

View: 表示プロパティの設定 

Help: バージョン情報 

サーチ: サーチウィンドウを起動します 

カウントビュー: シグナルを発生カウントベースで表示するウィンドウを起動します 

グループビュー: ID の生値を表示するウィンドウを起動します 

ヘルプ 

トリガポイントを<S>、イベントマーク位置を<EV>の表記とともに垂直線でグラフ上に表示します 

チ ャ ネ ル 番

号、チャネル

名、単位を

表示 

エキスポート 

ズーム、ズームアンドゥ、ズーム全解除 

MBD ファイルリストの表示: シグナルの詳細を表示します 

ファイルを開く 

 

 

 

 

 

 

 

 

 

 

 

 

 

右端をクリックすると横軸スケールの選択ができます 

second: 経過時間表示(秒) 

time: 経過時間表示 

date: 実時刻表示 

C1 カーソルの時間

C2 カーソルの時間

C1 カーソル - C2 カーソル間の時間 

ステータスを表示 現在オープンしているファイル名をフルパスで表示 ウィン
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波形を画面全体に 

展開して表示
スライダを下にドラッ

グすると Y 軸を全体

に拡大 

 

ドウ右端の時間 
各チャネルの表示を有効・無効にする

ウィンドウを起動します
各チャネルのカーソル位置の値を

表示するウィンドウを起動します
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9.2.2. チャネルの表示 

ウィンドウ下部の、       をクリックすると<Select Channel>を表示します。 

 

表示するチャネルを個別に選択することができます。 

 

 
チェックをつけたチャネルを

表示します  

 

 

 

 

 

 [SHIFT] + [上下キー]、 

または、[Ctrl] + [左クリック]

で複数チャネルの同時選択が

できます 

 

 

 

 

 

 

 

 

 

 
Channel:  チャネル番号とシグナル名を表示します 

Range (Max)/Range (Min): Y 軸の表示最大値・最小値を示します 
Box:  
Item:  
Auto: Exit: オートレンジ表示機能が ON か OFF かを示します 

Line: 前のデータと次のデータとの区間の描画方法を示します  

Mountain では次のデータとの区間を直接直線で結びます 

Stair では次のデータとの区間を水平線と垂直線階段上に結びます 

 

これらの設定は、後述する<Channel Property>で行います 

Enable:  選択されたチャネルの表示を有効にします 

All Enable: すべてのチャネルの表示を有効にします 

Disable:  選択されたチャネルの表示を無効にします 

All Disable: すべてのチャネルの表示を無効にします 

Exit: <Select Channel>を終了します 

 

 

 

 

 

 

 

 

 

 
9.2.3. カーソルの利用 

C1、C2 の 2 本のカーソルを用いてデータ値の読み取りや、カーソル区間をズーム表示することができます。 

 
データ値の読み取り 

1. 新たに波形表示ウィンドウィンドウにファイルが表示されると、C1 カーソル、C2 カーソルはそれぞ

れ波形表示の左端と右端に位置しています。 

C1 

 

2. 左端のカーソル位置にマウスを移動するとマウスポインタが<⇔>に変わります。 

 

3. そのままの状態でマウスをドラッグして C1 カーソルを引き出し、データ読み取りを行う位置まで

移動します。 

 

4. 同様に右端の位置から C2 カーソルを引き出します。 

 

5. C1 カーソル、C2 カーソルのポイントの各チャネルの時間と値が波形表示部右側に表示されま

す。(上段に C1 カーソルの時間と値を表示、下段に C2 カーソルの時間と値を表示) 
C2 

 

6. ここで読み取られたデータ値は、カーソル上または、カーソル上にデータのない場合は直前位置

のデータ値(データ位置を○印のポイントで表示)です。 
 

 注意 

CAN や診断通信のデータは、発生タイミングベースで収録されているため、必ずしも全データの取得

タイミングが同一のカーソル線上に存在するわけではありません。本プログラムでは、カーソル線の位

置する時間軸上での最新のデータ発生位置を○印によって示します。○印の位置のデータがその

時のカーソル値の値として読み取られることになります。 
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7. C1 カーソルと C2 カーソル間のデータの詳細を表示するために、 
ウィンドウ下部の          をクリックします。 
 

8. 波形表示ウィンドウ下部に<Wave Parameter>が表示されます。 
Channel: チャネル名が表示されます。 

Range(Max)/Range(Min): 表示レンジ(Y 軸)の最大値・最小値です。グラフスケールでは点線

の水平線で示されます。初期値は、設定ファイル(CND ファイル)に規定された該当シグナルの最大

値・最小値となります。先に記述する<Channel Property>により軸設定の変更が可能です。 

C1 (X)/C2 (X) : C1 カーソル、C2 カーソル位置にあるデータの時間です。 

C1 (Y)/C2 (Y) : C1 カーソル、C2 カーソル位置にあるデータの値です。 

Abs (C1-C2) : C1 カーソルと C2 カーソル位置のデータの差分です。(絶対値) 

Max (C1-C2) : C1 カーソルと C2 カーソル位置にあるデータの中の最大値です。 

Min (C1-C2) : C1 カーソルと C2 カーソル位置にあるデータの中の最大値です。 

 

 

9. <Wave Parameter>の左上のコーナー部分をマウスでドラッグすると、<Wave Parameter>
を波形表示ウィンドウ内、左側や上側に配置することもできます。 

<Wave Parameter>を元の位置に戻すには、波形表示ウィンドウ下側にドラッグ&ドロップします。 

 

 

 

 

 

 

 

 

 

 

 

 

時間軸のズーム 

1. C1 カーソル、C2 カーソルで時間軸のズーム表示を行いたい区間を囲みます。 

 

 

 

 

 

 

 
間

 

 

 

 

 

 

2
 

3
 

 

4
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ズーム対象区
. ツールバーの          をクリックします。 

. カーソルで囲まれた区間の時間軸がズーム表示されます。 

. ズーム表示を解除するには、ツールバーの次のボタンをクリックします。 

     : ひとつ前に戻る 

: ズーム全解除 
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9.2.4. 重ね描き表示 

チャネル表示の重ね描きを行うことができます。複数チャネルの重ね描きも可能です。 

各チャネルの Y 軸表示スケールの変更は、<Channel Property>で行います。 

 

1. データを波形表示します。 

 

 

 

 

 

 

 

 

 

 

 

2. 重ね描き元の波形表示ウィンドウ左のチャネル情報部分を重ね描き先のチャネルまでドラッグ

します。ドラッグしたチャネルのチャネル情報部分は濃いグレーに変わります。 

 

 

 

 

 

 

 

 

 

 

3. 重ね描き先のチャネルにドロップします。 

 

 

 

 

 

 

 

 

 

 

 

4. 重ね描きされたチャネルのチャネル情報表示は次のようになります。左の X をクリックすると重ね

描き解除します。◂▸をクリックすると重ね描きチャネルの表示順を変更することができます。 
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9.2.5. チャネル・プロパティ 

<Channel Property>では、各チャネルのグラフ描画のスタイルや Y 軸の表示スケールを変更することができます。 
 

1. 波形表示ウィンドウ下部の         をクリックして<Wave Parameter>を表示します。 

 

 

 

 

 

 

 

 

 

 

 

2. <Wave Parameter>のチャネル位置でダブルクリックすると、そのチャネルの<Channel 
Property>が表示されます。 

 

 

 

 

 

 

 

 

 
 

項目 説明 

channel name 収録時に設定されたシグナル名、またはチャネル名が表示されます。 

Unit 収録時に設定された物理量単位が表示されます。 

Coefficient 収録時に設定された物理量変換係数が表示されます。 

Display Y 軸表示スケールを設定します。 

max 表示最大値を入力します。デフォルトでは収録時に設定されたシグナルの最大値、またはレンジ最大値が表示されます。 

min 表示最小値を入力します。デフォルトでは収録時に設定されたシグナルの最小値、またはレンジ最小値が表示されます。 

same  

reset 収録時に設定されたシグナルの最大・最小値、またはレンジ最大・最小値に戻します。 

mountain チェックを付けると、データのある二点間を斜めに結んでグラフ表示を行います(mountain)。 

チェックをはずすと二点間を水平線と垂直線で結びます(stair)。 

auto range チェックを付けると表示データの最大値と最小値をスケールとして表示します。 

all channel チェックを付けた後の操作を他のすべてのチャネルに適用します。 

Color グラフラインと背景の色を設定します。 

Line グラフラインの色を設定します。 

▾ クリックするとカラーパレットが表示され色を選択できます。 

same ここで設定された色をすべてのチャネルに適用します。 

reset すべてのチャネルをデフォルト色に戻します。 

Back グラフ背景色を設定します。 

▾ クリックするとカラーパレットが表示され色を選択できます。 

same ここで設定された色をすべてのチャネルに適用します。 

reset すべてのチャネルをデフォルト色に戻します。 

 

mountain      stair 
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9.2.6. スクロールバー操作 

波形表示ウィンドウ右端のスクロールボタンを下方向に動かすと、各チャネルの Y 軸グラフ表示範囲が拡大します。 

 

波形表示ウィンドウ右上にある        ボタンに上下矢印が表示されている場合、このボタンをクリックすると現在表示されていないチャネルも含めて一画面

に表示することができます。 

ただし、表示チャネルが多い場合は、一画面に表示できない場合もあります。 

 

現在の画面に表示されていないチャネルを表示するためには、ウィンドウ右の上下スクロールバーを操作します。 

また、X 軸方向のデータ表示を移動するには、ウィンドウ下の左右スクロールバーを操作します。 

いずれのスクロールバーの大きさも、全体のデータの中における現在の表示範囲の割合を示します。 

スライダコントロールでは、Y 軸方向の表示サイズの変更ができます。 

 

 

 

 
左右スクロールバー 

 

 全画面表示に 

 

 

 上下スクロールバー 

 

 

 スライダコントロール 
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9.3. 応用操作 

 
9.3.1. サーチ 

サーチ条件を設定することによって、必要なデータ切り出し区間を選択することができます。 

 

1. ツールバーにある        をクリックします。 

 

2. <Search>が表示されます。次の設定ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

項目 説明 

Start Condition 表示しているファイルの収録時間を秒で表示します。 

Time(1) 切り出しの開始ポイントを秒数で設定します。 

Time(2) 切り出しの開始ポイントを時刻で設定します。 

Mark EVENT 位置へ移動します。 

Level チェックをつけて有効とすると、レベルで切り出しを行う監視対象のシグナル名、トリガの方向、スレショルド値の入力ができます。 

下の<PreTime>、<PostTime>でレベル切り出しの前後のトリガ領域の秒数を設定できます。 

PreTime <Level>がチェックされると有効になります。レベル切り出しの前の領域を秒数で選択します。 

PostTime レベル切り出しの後ろの領域を秒数で選択します。 

PostTime に秒数を入力し[Search]をクリックするとここで設定された秒数のスケールに表示軸を合わせることもできます。ただし、この時間軸スケー

ルは使用している PC の内蔵メモリー量により自動的に調整され、入力された秒数とは必ずしも一致しません。 

Search 切り出しを実行します。 

Close ダイアログを終了します。 

 

 

9.3.2. データの切り出し 

[File] ⇒ [Export...]をクリックすると<Export>が表示されデータの切り出しを行うことができます。デフォルトで入力される切り出し区間は、現在の波形表

示ウィンドウの表示範囲となります。 

任意の区間を切り出すためには、ズーム操作により区間を特定するか、あるいは<Export>表示後、任意の切り出し区間を秒数で<from>と<to>に入力、

またはサーチにより表示範囲の切り出しを行います。 

 

 注意 

切り出し区間は秒単位の設定となります。 

 

 

 

 

 

 

 

 

 

 

 

項目 説明 

from 切り出しの開始ポイントを秒で入力します。 

to 切り出しの終了ポイントを秒で入力します。 

Channel 左のボックスにチェックを付けたチャネルが切り出し対象チャネルとなります。 

output file 右側のボタンをクリックすると<Save>が表示され、切り出し先ファイルのディレクトリとファイル名を設定します。 

Convert 切り出しを開始します。切り出し中は<Now converting...>が表示され、進行状態が確認できます。ダイアログ中の[CANCEL]をクリックすると切

り出しを中断します。 

Exit ダイアログを終了します。 
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9.3.3. カウント表示 

任意の 1 チャネルを選択し、カウントベースでデータを表示することができます。 

 

1. ツールバーにある         をクリックします。 

 

2. 波形表示ウィンドウ下部に<Count View>が表示されます。 

<Count View>は、<Wave Parameter>と同様の操作で波形表示ウィンドウ内部に移動するこ

とができます。 

 

 

 

 

 

 

 
Count View 
 表示区間内のデータの値でオートスケールを行いデータ表示します 両端に位置するカーソルを引き出して、時間とデータ値を読み取ることができます
 

 

 

 

 Start Point/Scale: 現在の表示範囲の開始ポイントとスケールを示します
 

 set: 左側のボックスに手入力されたカウント表示の開始ポイントとスケールをセットします 

スケールの最大値は 100000 です 

prev: 前の表示セグメントに戻ります 

next: 次の表示セグメントに移動します 

カウント表示を行うシグナル名を選択します 
 

 

 

 

 

9.3.4. データの生値表示 

C1 カーソル位置のデータの生値を表示することができます。 

 

1. ツールバーにある         をクリックします。 

 

2. 波形ウィンドウ表示画面上部に<group view>が表示されます。 

<group view>は、<Wave Parameter>と同様の操作で波形表示ウィンドウ内部に移動するこ

とができます。 
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9.3.5. CAN 丸取りデータの表示 

CAN 丸取りまたは ID フィルタリングによって収録されたデータは、初期状態では波形表示ウィンドウには表示されません。 

データベースを用いて、収録された ID のうちどのシグナルを分解して表示するか設定を行います。 

ここでは、CAN1 で 8 個のシグナルが収録され、CAN2 では丸取りが行われた場合の表示操作例を示します。 

 

1. 起動時に表示された<Open>でファイルを選択するか、[File] ⇒ [Open...]をクリックして

<Open>を表示し該当のファイルを選択します。 

 

2. シグナル収録が行われた CAN1 のデータが表示されています。 

 

3. ツールバーにある           をクリックします。 

 

 

 

 

 

4. <MBD File List>が表示されます。現在表示されているチャネルのリストです。 

 

 

 

 

 

 

 

 

 

シグナル名をクリックで選択し、[CAN Delete]をクリックするとそのシグナル名は表示チャネ

ルから削除されます。 

シグナル名の複数選択は、[Shift] + [上下キー]、[Ctrl] + [左クリック]で行います。 

 

 

5. <CAN Port>で丸取りまたは ID フィルタリングにより収録が行われたポートを選択します。(この

場合は、[CAN2]となります。) 

 

6. [.dbc file]をクリックすると、<ファイルを開く>が表示されます。丸取りまたは ID フィルタリングが

行われたポートで収録されたデータをシグナルに分解するためのデータベース(CANdb)を選択します。

(丸取りまたは ID フィルタリングが行われていないデータの場合は[.dbc file]の選択は無効です。 

 

 

 

 

 

 

7. [開く(O)]をクリックすると、<CANdb List>が表示されます。 

 

 

 

 

 

 

 

 

 

 

シ

し
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シグナル名の複数選択は、[Shift] + [上下キー]、[Ctrl] + [左クリック]で行います。 
 

グナルに分解したいシグナル名のチェックボックスをマークします。(この例の場合、EngSpeed を選択

ました。) 
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8. [OK]をクリックすると、<MBD File List >が表示されます。選択されたシグナルは、リストの後

ろに追加されます。 

 

 

 

 

 

 

 

表示を行うために、先頭のチェックボックスをマークします。 

この場合、先ほどシグナルに分解された EngSpeed を表示チャネルの 10ch に追加しました。 

 

9. [Exit]をクリックすると、丸取りされた CAN2 ポートで収録された EngSpeed を含む波形表示と

なります。 
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9.4. 印刷機能 

画面に表示されている波形を、プレビューして印刷することができます。 

1. [File] ⇒ [Page Setup...]をクリックして<ページ設定>を表示します。 

ここでは用紙の選択や、印刷の向き、余白などの設定ができます。 

[OK]をクリックして次に進みます。 

 

 

 

 

 

 

 

 

 

 

 

 

2. [File] ⇒ [Print Preview]をクリックします。 

先の設定にしたがって印刷イメージが表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

3. [印刷]をクリック、 

または、[閉じる]をクリック、[File] ⇒ [Print…]をクリックして印刷を行います。 
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9.5. その他 

 
9.5.1. トリガポイント、イベントマークやエラーフレームの表示 

トリガによって収録されたファイルの表示 

<S>の表示と垂直線がトリガポイントを示し、それより左側がプリトリガ領域、右側がポストトリガ領域となります。 

 
<S>の表示

 

トリガ対象チャネルをグレーで表示 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

EVENT が記録されたファイルの表示 

トリガポイントの表示部分に、EVENT 位置を<EV>と垂直線で示します。 

 

 

CAN エラーフレームの表示 

VD-X1 は CAN エラーフレームも同時に収録することができます。各 CAN ポートの波形表示データの最終チャネルに、このエラーフレームの発生情報チャネル

が表示(チャネル情報部分には、<ERROR_FRAME>と表示)されます。エラーフレームの発生位置を○印で表示します。 

 

 

 

9.5.2. ビューメニュー 

View メニュー 

ツールバーとステータスバーは、[View] ⇒ [Toolbar]、[Statusbar]をクリックすることで表示の ON/OFF ができます。 

 

[View] ⇒ [View property]をクリックすると、<View property>.が表示され、プログラム終了時

の表示情報を次にプログラムを起動したときに残すか残さないかの選択ができます。表示情報を残

さない場合は、<Reset view information whenever importing file>の左のボックスをチェック

します。 

また、日本語フォントを正しく表示する場合には、<Use Japanese font>をチェックして下さい。 

 

 注意 

表示情報が残された場合は、表示対象のチャネル数の情報も残ります。したがって、前回オープン

したファイルの収録チャネルが今回オープンしたファイルの収録チャネルよりも少ない場合は、すべての

チャネルの表示が行われませんので注意して下さい。 

 

 

9.5.3. バージョンの確認 

 

ツールバーの        をクリックするとプログラムのバージョンが確認できます。 
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第 10 章 仕様 

 

10.1. ハードウェア 

入出力 

ECU 関連 

CAN  2 ポート  

   対応プロトコル: ISO-11898-1  2.0A (11 ビット標準 ID) 、2.0B (29 ビット拡張 ID) 

   最大設定転送レート: 1 Mbps 

コネクタ  D-Sub 9 ピンコネクタ x 2  CAN1 コネクタ および CAN2 コネクタ 

アナログ入力 

チャネル数  8 

入力レンジ  ±1V、2V、5V、10V 

S/N  52 dB (±5V レンジ 100Hz) 

サンプリング周波数 最大 1 kHz x 8 チャネル 1 kHz/500 Hz/200 Hz/100 Hz/50 Hz/20 Hz/10 Hz/5 Hz/2 Hz/1 Hz 

ADC  16 ビット逐次比較方式 準同時サンプリング 

コネクタ  D-Sub 9 ピンコネクタ 

 注意 

上記各ポートは、それぞれ独立して動作します。 

ただし、複数ポートで後述するデータ収録機能を複数動作させた場合、収録のとり逃しを発生する場合があります。 

 

収録先デバイス  

メモリーカード  内蔵メモリーカードスロット(2 スロットのうちどちらか片方を自動認識)に挿入されたコンパクトフラッシュ 

   メモリーカードにデータを収録 

   対応カード: コンパクトフラッシュタイプメモリーカード(カードアダプタ要)  

   (株)ハギワラシスコム Z-pro シリーズ (128MB ～ 2GB) 

   FAT16/FAT32 対応  

 注意 

当社で検証・確認済みのカードをご使用下さい。それ以外のカードでは充分な性能が発揮できない場合があります。 

 

CPU 部 

CPU  VIA Eden ESP5000 533MHz 

メモリー  PC133 SDR SDRAM 128MB  

OS  Linux Kernel Version 2.4 (詳細 2.4.20) 

 

表示部 

本体  6.3 インチ カラーLCD 1024 x 768 ソフトキーによるバックライト輝度調整可能 

モニター出力  外部ディスプレイ用 VGA 出力端子つき 

 

操作キー 

本体  STOP/REC(REC スタンバイ状態に)/FWD(REC スタンバイ時、収録スタート)/PAUSE/EVENT  

   状態表示 LED つきキー 

ブザー音  キー操作に連動したブザー音の ON/OFF 設定可能 

 

インタフェース  

インタフェース  100BASE-TX/10BASE-T   

無線 LAN  無線 LAN カードにて対応(ただし当社指定のもの) 

リモコン  オプション ER-VDRC リモコン  

CONTROL コネクタ リモコンと兼用  

  

電源  

AC  付属 AC アダプタにて 100 V ～ 240 V AC 

DC  12 V DC (10 V ～ 17 V DC) (内蔵電池等による動作バックアップ機能はありません) 

   CAN1 コネクタ(9 番ピン +12 V  3 番ピン GND)または、DC 入力コネクタに接続された  

   DC 電源のうち、どちらか高圧の方で動作、ダイオードによる入力切り替え 

消費電力  36 W  

 

その他 

動作温度  5 ℃ ～ 40 ℃ 

振動・衝撃  MIL-STD-810E 

本体外形寸法 約 200 W x 60 H x 205 D mm (突起部除く) 

本体質量  2.3 kg (AC アダプタ除く) 
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10.2. 機能 

ECU データ収録機能 

CAN  各ポート個別に丸取りモード、またはシグナル収録モード(ポートあたり最大 32 シグナル収録)の選択 

   丸取りモード時、ID フィルタリング可能、最大設定 ID フィルタリング数 32/ポート、 

    

 注意 

各データとも本体にて収録時のタイムスタンプをデータのヘッダにつけて保存します。 

データ収録機能を複数動作させた場合、収録のとり逃しを発生する場合があります。 

 

対応データベース 

CANdb  対応(ただしテキスト形式) CAN シグナル収録に適用 

 

間引き収録モード 

間引き設定  CAN 丸取りおよびシグナル収録のみに適用 

   マニュアル収録モード、およびプリトリガ/ポストトリガ収録モードに適用 

   設定された時間ごとにその直後のデータのみを収録 

設定範囲  10msec/20msec/50msec/100msec/200msec/500msec/1sec/2sec/5sec 全ポート共通設定 

 

アナログ信号収録機能  

チャネル名  設定可能(英数字で最大 16 文字) 

係数設定  各チャネルにオフセット値(指数表記可)とスロープ値(指数表記可)設定可能 

キャリブレーション 起動時および設定変更時に実行(オフセット値とスロープ値を算出、データヘッダに反映) 

 

トリガ機能  

収録動作モード トリガ: プリトリガ時間設定 0 でトリガ成立時自動的に収録開始 

   プリトリガ: 最大設定時間 120 秒 (ただしバッファサイズ 16MB 以内) 

   ポストトリガ: 最大設定時間 32768 秒 0 秒では、STOP キーにて収録停止 

   繰り返し: 最大 32768 回、0 と 1 では一回のみ収録 

設定項目  シグナル収録、項目設定モードの場合のみ有効 

   各 4 項目を一つのグループとした成立条件を設定し、さらに最大 4 グループ間の条件設定が可能 

トリガ設定対象 CAN/アナログ 

検知方式  エッジ、ただし収録開始時にトリガ条件を満たす場合は、トリガ成立とする 

 注意 

FWD キー、STOP キー、メディアフルが先に成立した場合は、これらの動作が優先されます。 

CAN はシグナル収録のみがトリガ収録対象となります。 
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リアルタイムモニター  

本体 

表示画面  4 画面/上下 2 画面/左右 2 画面/1 画面の選択 

表示モード  CAN: HEX FLOW/HEX TRACE/CAN SIGNAL/CAN GRAPH/DIGITAL 

   アナログ入力: BAR/GRAPH/DIGITAL 

   STATISTICS 

    FLOW: 生値を発生順にタイムスタンプとともに表示 

    TRACE: 選択された項目の生値を表示 

    SIGNAL: シグナル値を表示 

    GRAPH: 4 つのシグナルの波形表示 

    BAR: バイポーラタイプのバーメータ表示(ピークホールドつき、解除は ENTER キーにて) 

    DIGITAL: シグナル値の表示、ディジタルパネルイメージ 

    STATISTICS: CAN バスのエラー統計表示 

    TRACE モードでは、CAN エラーフレームの表示可能 

 注意 

CAN 丸取りの時は SIGNAL、GRAPH、DIGITAL は選択できません。 

収録ファイル情報 収録開始時、および収録中の SHIFT キー押しにて次の情報を設定秒間表示 

   収録ファイル名、トリガ成立要因、イベント回数 

簡易再生  FWD キー押しで最終収録ファイルの再生表示(ただし収録時の設定条件と同一のこと) 

PC 

表示モード  本体グラフ表示設定と同じチャネルの VdRmt プログラム上でのグラフ表示 

   画面分割も本体設定に連動、本体設定でグラフ以外の表示となっている場合、その部分はブランクとなる 

 

収録ファイル設定 

ディレクトリ  ディレクトリ名の設定 

収録ファイル  収録ファイル名の設定、ここで設定されたファイル名(英数字、ロングファイル名使用可能)の 

   後ろに 00001 から始まる 5 桁の連番をつけてファイルを作成(FWD から STOP で１ファイル) 

コメント  設定されたディレクトリに対してコメント入力可能、最大 255 英数字 

 

収録ファイル削除 

   最終収録ファイルの削除可能 

 

システム設定 

LCD コントラスト 5 段階 

LCD セーブ  1min/3min/5min/10min/なし  

   設定された時間内にキー操作がないときは LCD バックライトを消灯 

キービープ  無効/有効 

自動設定ロード 無効/有効 有効の場合、カードに収録された CND ファイルをブート時自動的に読み込み 

   システム設定を行う。 

時計設定  PC および本体キー操作にて時刻の設定可能 

BootOnREC  起動時に自動的に REC スタンバイ状態にする(ただし PC メモリーカードが挿入されていること) 

DirectREC  REC スタンバイ状態遷移と同時に収録開始 

 

収録ファイル形式 

形式  MBD データフォーマット(TEAC Proprietary) 別途ファイル形式仕様書を用意 
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10.3. 補足 

入力文字数制限一覧表 
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ユーザー登録のおすすめ 
登録いただいたお客様には本製品のサポートについての情報や新製品などの情報をお知らせいたします。 

また、当社が妥当と判断した特定のバージョンアップを無償にて実施させていただきます。登録いただくにはつぎの３つの方法があります。 

●オンライン登録 

下記ウェブサイトにて登録して下さい。 URL: http://www.tic.teac.co.jp/ 

●ファックスによる登録 

下記の<ユーザー登録記入欄>に必要事項を記入いただき、このページをコピーしてファックスして下さい。(FAX: 044-711-5240) 

●郵送による登録 

下記の<ユーザー登録記入欄>に必要事項を記入いただき、このページをコピーして郵送して下さい。 

宛先: 〒211-0067 神奈川県川崎市今井上町83 ティアック電子計測株式会社 CS課 

 

型名 VD-X1 

シリアル番号 No.  

ご購入日  

貴社名  

ご所属  

ご担当者  

ご住所  

TEL  

FAX  

E-mail  

E-mail による情報提供 □ 希望しない 

備考  

 

お客様の個人情報の取扱いについて  
当社は、上記に基づき登録を頂いたお客様の個人情報について、当社の個人情報保護方針に基づき、下記の要領で取扱いをさせていただきます。  

1. 個人情報管理者  

お客様の個人情報については、下記の者を個人情報管理者として置き、適切なセキュリティを確保し、安全に保管いたします。  

ティアック電子計測株式会社 CS 部 部長 稲谷猛 (電話） 044-711-5221 (E-mail） intanit@tic.teac.co.jp  

2. 個人情報の収集および利用目的  

登録いただいたお客様の個人情報は以下の目的のために利用する場合があります。  

(1) 保証期間内のサービス活動およびその後の安全点検活動のため。 

(2) 今後の商品開発の参考とするため。  

(3) 商品の発送を行なうため。  

(4) 関連するアフターサポートを提供するため（ソフトウェア等のバージョンアップ情報のご提供を含みます）。  

(5) 新商品・サービスに関する情報を提供するため。  

(6) 展示会に関する情報を提供するため。  

(7) ご利用者の属性（住所など）ごとに分類された統計的資料を作成するため。  

3. 個人情報の第三者への提供  

登録いただいたお客様の個人情報は、次のいずれかに該当する場合を除き、いかなる第三者にも開示・提供いたしません。  

(1) ご利用者にサービスを提供する上で必要となる業務委託先に開示する場合。  

(2) 前項に定める利用目的のために、ティアックグループ会社に開示する場合。  

(3) ご利用者が事前に承諾された場合。  

(4) 法令により開示が要求される場合。  

(5) ティアック、ご利用者または、第三者の権利または財産を保護するために開示する必要がある場合。  

4. 個人情報の開示を求める権利および開示の結果、当該個人情報が誤っている場合に訂正または削除を要求する権利の存在ならびに当該権利を行使するための

具体的方法  

登録いただいたお客様個人の登録内容の確認を求められる場合、または、個人情報の内容の訂正、削除を求められる場合は、下記までご連絡ください。  

ティアック電子計測株式会社 CS 部 (電話） 044-711-5221 (E-mail） tic_cs@teac.co.jp  

 

おことわり 
仕様および外観は予告なく変更する場合があります。 

最新の仕様につきましては当社までお問い合わせ下さい。 

記載の会社名および商品名はそれぞれ各社の登録商標です。 

このユーザーズマニュアルの記載内容は 2005 年 7 月現在のものです。 

 

Copyright © 2004, 2005  TEAC Instruments Corporation.  All rights reserved. 
 

お問い合わせ先 
ティアック電子計測株式会社  

〒211-0067 神奈川県川崎市今井上町83 

CS 課 電話: 044-711-5221 

  FAX: 044-711-5240 

  E メール: tic_cs@tic.teac.co.jp 
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